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Part 1: IP Office Virtual Servers
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Chapter 1: IP Office Virtual Servers

Avaya supports the installation of its Linux-based IP Office servers as virtualized servers. Using a
virtual software platform allows the customer's IT staff flexibility to maximize the use of the platform's
hardware to meet the individual needs of each virtual machines it hosts. It also provides them with
access to various tools that ease maintenance and monitoring processes.

• For IP Office R11.1 FP1, IP Office is supported on the following virtual server platforms:

- VMware

- Microsoft Hyper-V

- Amazon Web Services (AWS)

- Microsoft Azure

• Avaya does not provide or support the virtual server software and hardware chosen by the
customer.

• Use this document in conjunction with the documentation for standard IP Office deployments,
see Related Documentation on page 8. This document only provides notes for the initial
deployment of the server software as a virtual machine.

• Avaya only supports virtual machines using the virtualized server images supplied by Avaya.
Resellers and customers who create their own image files for virtual deployment are solely
responsible for the support and maintenance of those products.

• In addition to certified IP Office training, the installer and system maintainer must have certified
training on the specific virtual platform type or supported by someone who has the required
certification.

Related links
Duplicate IP address issue on page 7
IP Office Anywhere on page 8
Related Documentation on page 8

Duplicate IP address issue
The virtual machine deploys by default with two virtual network interfaces and two IP addresses,
LAN1 and LAN2. At the start of deploying, if a duplicate IP address is detected, that is the address
that is already in use, then IP Office application stops.
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For example, if you deploy two IP Office virtual machines and only configure the LAN1 address on
each, the matching default LAN2 addresses (192.168.43.1) on each causes the IP Office
application on both virtual machines to stop.

During deployment, you must ensure that the deployment of oneIP Office virtual machine has
completed, including setting the LAN1 and LAN2 IP addresses to the required values, before
starting the deployment of any other IP Office virtual machine.

If the LAN2 port of an IP Office virtual machine is not required, you can disable it. This reduces the
risks of conflicts. Disabling a port is detailed as an optional step in the deployment process in this
manual. See Disabling a VMware network port on page 42

Related links
IP Office Virtual Servers on page 7

IP Office Anywhere
IP Office Anywhere is a special version of the Linux-based IP Office service intended for product
demonstrations and evaluation. It includes a pre-built and pre-licensed IP Office configuration.
Anywhere can be installed on a physical server or any of the virtual platforms listed above, it is
also supported on VMware Player and Oracle VirtualBox virtual server platforms. See Installing
the IP Office Anywhere Demonstration Software manual for installation procedure.

Related links
IP Office Virtual Servers on page 7

Related Documentation
This section lists the related documents for the products and solutions referenced in this
document.

In addition, you should also refer to the VMware documentation. This is available from VMware
Support Offerings.

Application Server
• Avaya IP Office™ Platform Solution Description
• Avaya IP Office™ Platform Server Edition Reference Configuration
• Deploying IP Office Server Edition

Application Server
• Installing and Maintaining an IP Office Application Server

IP Office Virtual Servers
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IP Office
• Administering Avaya IP Office™ Platform with Manager
• Administering Avaya IP Office™ Platform with Web Manager

Voicemail Pro
• Administering IP Office Voicemail Pro
• Voicemail Pro Example Exercises

one-X Portal for IP Office
• Administering Avaya one-X Portal for IP Office
• Using one-X Portal for IP Office

Related links
IP Office Virtual Servers on page 7
Downloading documents on page 9

Downloading documents
Procedure

1. Browse to http://support.avaya.com and log in.

2. Select Downloads & Documents.

3. In the Enter Your Product Here box, type IP Office.

4. Use the Choose Release drop-down to select the required IP Office release.

5. Select the content type you want included in the list of documents.

6. Click Enter.
Related links

Related Documentation on page 8

Related Documentation
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Chapter 2: Virtual server licensing

IP Office systems use licenses to enable various IP Office applications and features. IP Office also
use licenses to enable each Server Edition or IP Office Select server.

For applications and feature, virtualized IP Office servers use the same licenses as used on non-
virtual server deployments. However, for the server's themselves, Virtualized Server Edition and IP
Office Select servers consumes specific Virtualized Server Edition or Virtualized Server Edition
Select licenses respectively rather than standard Server Edition or Server Edition Select licenses.

PLDS licenses can be hosted in the network in one of two ways:

• WebLM Centralized Licensing: A PLDS file containing the licenses is uploaded to the WebLM
service running on the network's primary server. The licenses are issued or validated against
the host ID of the WebLM service. The host ID is automatically generated from various initial
configuration settings of the server but does not subsequently change. Through the license
menus, the servers in the network, including the primary, request licenses from those available.
Due to its flexibility this is the recommended method of licensing.

• Local Nodal Licensing: A PLDS license containing the licenses is uploaded to the IP Office
running on the server. The licenses are issued or validated against the PLDS Host ID of the
server. The host ID is automatically generated from various initial configuration settings of the
server. When the system configuration changes, the host ID also changes.

Related links
Nodal PLDS Host ID Restrictions on page 10
Nodal License Grace Period on page 11

Nodal PLDS Host ID Restrictions
If the server is hosting its own licenses, then Avaya validates each license against the server's
unique PLDS Host ID. For an IP Office virtual machine, theIP Office generates the PLDS Host ID
based on several factors:

• Deployment Specific Factors: The PLDS Host ID is partially based on several factors
relating to the particular virtual machine's deployment. Redeploying the virtual machine
changes its PLDS Host ID, thus existing licenses in IP Office configuration becomes invalid.
To move to another virtual server platform without requiring new licenses, use vMotion.
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• Configuration Specific Factors: The PLDS Host ID is also partial based on the following
parameters of the virtual machine. Changing any of these parameters changes the virtual
machine's PLDS Host ID:
- Host Name
- LAN1 IP Address
- LAN2 IP Address
- Timezone
- DHCP Mode

Related links
Virtual server licensing on page 10

Nodal License Grace Period
If the virtual machine already contains nodal licenses and the PLDS Host ID changes, the
licenses remain valid for a 30-day grace period. During those 30 days, if you make more than five
further changes to the configuration parameters existing licenses become invalid immediately.
Therefore, it is recommend that you finalize all these parameters before acquiring any licenses
from Avaya

Related links
Virtual server licensing on page 10

Nodal License Grace Period

October 2021 Deploying Avaya IP Office Servers as Virtual Machines 11
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Deploying Avaya IP Office Servers as Virtual Machines


Chapter 3: Differences in operation

Largely, the operations of virtual version of Server Edition match that of the non-virtual Server
Edition installations.

Related links
Original RPM files not installed on page 12
No USB support on page 13
VMware tools on page 13
Media Manager archiving on page 13
Primary cannot upgrade other servers on page 14

Original RPM files not installed
The installation of a non-virtual machine includes copying the original RPM files used for each
component's installation onto the server. Go to Updates menu and click Uninstall to uninstall the
component before reinstalling. The presence of the copied original RPM files allows reinstallation
on a non-virtual machine.

In order to reduce the size of the Avaya OVA file, by not including the original RPM files has the
following effects:

• You cannot reinstall the uninstalled components: You cannot reinstall a component if you
delete the RPM file it from the server's Updates menu. Instead you need to transfer the
appropriate RPM files to the server first.

• You cannot upgrade other servers from the Primary: If the server is a Primary Server, it
cannot be used to upgrade any Secondary Server or Expansion System (L) servers to match
its software level. However, it can be used to upgrade Expansion System (V2) servers.

You can resolve the issues by: Following the server upgrade process to upload an ISO image to
the server. This involves transferring a copy of the full ISO to the server, that automatically
unpacks a full set of RPM files necessary to upgrade both Primary and other servers.

Related links
Differences in operation on page 12
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No USB support
Avaya does not support features that require access to the virtual machine's USB port. This
includes using the USB port for upgrades and for external music on hold.

Related links
Differences in operation on page 12

VMware tools
VMware tools is used by the virtual machine management software such as the vSphere client
and vCenter to complete requested administrative tasks.

Avaya packages a specific version of VMware Tools as part of the IP Office OVA. This version is
tailored for the IP Office operating system.

You should not upgrade the IP Office virtual machine version of VMware Tools except when
advised by Avaya. Doing so could destabilize operation of the virtual machine and affect its
performance.

Related links
Differences in operation on page 12

Media Manager archiving
When the Media Manager application is configured and during the operation, when the disk
partition reaches full capacity, the older recordings are archived onto a Blu-Ray-R or DVD+RW
disk. However, while running on a virtual machine, this method of archiving is not supported.
Instead Media Manager deletes the oldest recordings when required to create space for new
recordings.

Note that archiving of recordings onto other devices such as Network Attached Storage (NAS) is
still supported.

Related links
Differences in operation on page 12

No USB support
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Primary cannot upgrade other servers
In a Server Edition network, the Primary Server can upgrade its connected Secondary Server and
Expansion System (L) servers to the same software level as itself. However, this does not work if
the Primary Server is a newly installed virtual machine.

This issue is related to the fact the OVA deployment does not include a set of the original RPM files
required for reinstallation of IP Office components. See Original RPM files not installed on page 12

The solution is to first upgrade the Primary Server using any of the documented methods, see 
Transferring the ISO File on page 89. The upgrade process includes loading all the original RPM
files onto the server which it can then use to upgrade other servers.

Related links
Differences in operation on page 12

Differences in operation
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Chapter 4: Profiling

The standard IP Office virtual machine assumes four CPUs, 3072 MB RAM and a 100 GB hard disk
(see Default virtual machine on page 16). However, the resources allocated should be adjusted to
meet the intended role of the virtual machine and to optimize the use of the virtual server platform's
available resources, especially if it is supporting multiple virtual machines.

The IP Office virtual machine requirements are outlined in the following tables. Depending on the
type of virtual server, the stage at which these can be adjusted may vary.

Some restrictions are:

• Network Ports: You must configure all IP Office virtual machines with two Ethernet ports. If
you are using vMotion, additional network port requirement will apply, see vMotion
requirements on page 24.

• Hard disk: Regardless of the IP Office virtual machine's role, it requires a minimum of 100 GB
of allocated hard drive space. However, if required additional hard disk space can be added.
See Adjusting the VMware disk space on page 39.

- If it is planned to run the Media Manager service on the virtual server, the requirement for an
additional hard disk for Media Manager still applies.

• Disk Storage IOPS Requirements: To maintain acceptable performance, the number of virtual
machines using the same disk storage and the total throughput of those machines must be
within the capacity of that storage. See Disk IOPS requirements on page 24.

• Profiling Other Virtual Machines: It is good practice to monitor the resource utilization of all
the virtual machines running in their infrastructure. Profile all virtual machines running on the
virtual server platform to fine-tune the hardware resources allocated and used. This will
improve performance by allocating resources where they are needed and optimize the use of
their virtual infrastructure.

• Multiple IP Office Servers: If deploying servers with the intention of using resiliency, then the
hardware resources and profiling applied to each server must include allowance for the
scenarios where users re-register from one server to the other, effectively increasing the
server's user requirements. If there is a mix of non-virtualized and virtualized machines, then
the assignment of resources to the virtual machine must match the hardware resources
available in the non-virtualized machine.

Related links
Default virtual machine on page 16
Primary and secondary servers on page 16
Server Edition Expansion Server (L) on page 18
Server Edition Application Server on page 18
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IP Office Application Server on page 19

Default virtual machine
The IP Office virtual images install a default virtual machine that matches the profiling values for a
typical 200 user Primary Server.

Hardware
configuration

Resource Allocation Memory Hard Disk

• vCPU: 4

• RAM: 3072MB

• HDD: 1x 100 GB

• CPU: 5 GHz

• Shares: High

• Reservation: 8000 Mhz

• Limit: Unlimited

• Shares: High

• Reservation: 2765 MB

• Limit: Unlimited

• Shares: High

• Limit: Unlimited

After deployment of a virtual machine, you should optimize the resources allocated to meet the
actual requirements of the virtual machine. See Profiling on page 15. For example, if the virtual
machine supports only 50 users, you can reduce the allocated processors and RAM memory. This
allows for the best use of the overall resources provided by the virtual server platform.

Related links
Profiling on page 15

Primary and secondary servers
The following table displays the minimum supported profile values for different IP Office virtual
machine roles in primary and secondary servers:

Server Type Primary and Secondary servers
Users [2] 20 100 20 50 100 200 500 1000 2000 3000
one-X Portal Users [2] - 5 16 20 40 88 175 351 703 1500
Voicemail Channels [2] 2 12 3 7 12 24 49 98 196 248 [3]

Web Collaboration
users [1] [2]

- 2 3 5 10 21 42 84 216 512

RAM (MB) Allocated 768 2048 2684
[6]

2684
[6]

3072 3072 4096 5120 6144 10240 14336

Reserved 625 1551 2416
[6]

2416
[6]

2624 2765 3358 4198 5376 8192 11909

CPUs 1 2–3 2–3 2–3 2–4 3–5 3–5 4–7 5–8 7–10 11-14

Table continues…

Profiling
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Server Type Primary and Secondary servers
Users [2] 20 100 20 50 100 200 500 1000 2000 3000
one-X Portal Users [2] - 5 16 20 40 88 175 351 703 1500
Voicemail Channels [2] 2 12 3 7 12 24 49 98 196 248 [3]

Web Collaboration
users [1] [2]

- 2 3 5 10 21 42 84 216 512

CPU Cycles
(GHz)

Limit 3 5 4 5 7 10 10 14 18 20 25
Reserved 3 4 3 4 6 8 8 12 15 17 21

Hard Disk (GB) [8,9] 100 100 100 100 100 100 130 140 150 160 160
IOPS [7] 15 31 17 18 26 41 71 129 248 338 346
AWS Machine Instance
[10]

m5.large m5.xlarge m5.2xlarge m5.4xlarge

1. Web Collaboration is only supported on the Primary Server.
2. If there is any profile misalignment between the user and channel quantities, use the

highest-profile that meets all requirements.
3. More than 250 recording channels with Media Manager requires approximately 12 vCPU

or 30 GHz CPU cycles in total.
4. Each connected one-X Portal client counts as one load. For example, Avaya IP Office Lync

plugin using Avaya Communicator for Windows for calls counts as two clients.
5. The CPU values shown apply to all virtualization platforms. However, for Hyper-V, the CPU

values should be increased by 20%.
6. If Media Manager is enabled, add 250MB RAM and increase the typical IOPS values.
7. Typical IOPS is the average HDD I/O transactions per second during normal operation.

When backup, intense logging or Media Manager are in use, more IOPS are required; 40
to 200 IOPS depending on backup data size, logging rate or recording channels.

8. Voicemail Pro requires 0.5 MB per minute for messages, prompts and announcements.
Each user and group mailbox is limited to up to 30 MB (1 hour).

9. Media Manager requires 60 KB per minute for non-authenticated VRL files and 120 KB per
minute for authenticated VRLA files. Media Manager also reserves 1 GB of space for the
call details database and other operations. Note that more than 250 channels of recording
requires at least 12 vCPUs and 30 GHz CPU cycles.

10. The quoted AWS machines instances are recommendations only. The range of machine
instances and the capabilities of existing instances change frequently. Therefore, other
instances can be used so long as their capabilities match the profiling resource
requirements.

Related links
Profiling on page 15

Primary and secondary servers
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Server Edition Expansion Server (L)

Server Type Server Edition Expansion Server (L)
Users 10 50 100 200 500 750
RAM Allocated 1024 1024 1024 1024 1024 1024

Reserved 887 896 900 900 903 906
CPUs 2–3 2–3 2–3 2–3 2–3 2–3
CPU Cycles (GHz) Limit 3 3 5 5 5 6

Reserved 2 2 4 4 4 5
Hard Disk (GB) 100 100 100 100 100 100
IOPS [1] Typical 5 5 6 7 9 11

Notes
1. Typical IOPS is the average HDD I/O transactions per second during normal operation.

When backup, intense logging or Media Manager are in use, more IOPS are required; 40
to 200 IOPS depending on backup data size, logging rate or recording channels.

Related links
Profiling on page 15

Server Edition Application Server
These profiling values are for an IP Office Application server being used to provide one–X Portal
service support to a Server Edition/Select server that has had its own portal service switched-off in
order to increase its supportable user capacity.

Server Type Server Edition Application Server
one-X Portal Users [1] 50 100 200 500 1000 2000 3000
Web Collaboration users [1] 9 18 35 86 171 342 512
RAM (MB) Allocated 3072 3072 3072 4096 6144 10240 14336

Reserved 2703 2703 2703 3548 5386 8555 12272
CPUs 2–3 2–3 2–4 3–5 4–6 4–6 4–6
CPU Cycles (GHz) Limit 6 6 7 10 11 11 11

Reserved 5 5 6 8 9 9 9
Hard Disk (GB) 100 100 100 100 100 100 100
IOPS [2] 10 10 11 16 18 20 21

Profiling
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Notes
1. If there is any profile misalignment between the user and channel quantities, use the

highest-profile that meets all requirements.
2. Typical IOPS is the average HDD I/O transactions per second during normal operation.

When backup, intense logging or Media Manager are in use, more IOPS are required; 40
to 200 IOPS depending on backup data size, logging rate or recording channels.

Related links
Profiling on page 15

IP Office Application Server
These profiling values are for an IP Office Application Server being used provide services to an
IP500 V2 running in IP Office Preferred Edition mode. This can be used to provide Voicemail Pro,
Media Manager and or one-X Portal support to the IP500 V2.

Server Type IP Office Application servers
one-X Portal Users [1] 50 100 200 750
Voicemail Channels [1] 20 50 100 150
Web Collaboration users [1] 20 50 100 300
RAM (MB) Allocated 3072 3072 4096 7168

Reserved 2739 2739 3420 6144
CPUs 2–3 2–3 3–5 4–7
CPU Cycles (GHz) Limit 5 5 9 13

Reserved 4 4 7 11
Hard Disk (GB) [3, 4] 100 100 100 100
IOPS [5] 34 49 162 318

Notes
1. If there is any profile misalignment between the user and channel quantities, use the

highest-profile that meets all requirements.
2. Each connected one-X Portal client counts as one load. For example, Avaya IP Office Lync

plugin using Avaya Communicator for Windows for calls counts as two clients.
3. Voicemail Pro requires 0.5 MB per minute for messages, prompts and announcements.

Each user and group mailbox is limited to up to 30 MB (1 hour).
4. Media Manager requires 60 KB per minute for non-authenticated VRL files and 120 KB per

minute for authenticated VRLA files. Media Manager also reserves 1 GB of space for the
call details database and other operations. Note that more than 250 channels of recording
requires at least 12 vCPUs and 30 GHz CPU cycles.

IP Office Application Server
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5. Typical IOPS is the average HDD I/O transactions per second during normal operation.
When backup, intense logging or Media Manager are in use, more IOPS are required; 40
to 200 IOPS depending on backup data size, logging rate or recording channels.

Related links
Profiling on page 15

Profiling
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Part 2: VMware
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Chapter 5: VMware Features

The following VMware features are supported.

Supported Virtual Servers
Avaya supports the IP Office virtual machine on the following virtual server platforms:

• VMware vSphere: The vSphere support is:
- Supported with VMware vSphere ESXi 6.0, 6.5, 6.7 and 7.0.
- Support includes the Standard, Enterprise and Enterprise Plus variants. Also support for

Essentials Kit and Essentials Plus Kit variants.

Supported VMware Virtual Server Features
• vCenter: VMware vCenter server, is the centralized management tool for the vSphere suite. It

allows the management of multiple host servers and virtual machines on different hosts
through a single console application.

• vMotion: vMotion allows you to move an existing virtual machine from one virtual server
platform to another with minimal interruption to the operation of the virtual machine. For
example, this may be necessary if the existing server platform resources become exhausted.
see vMotion requirements on page 24.

• Snapshot: The virtual machine must be powered off before taking or deleting a snapshot. Note
that running a virtual machine with snapshots degrades its performance. Similarly, deleting
snapshots can take some time to complete and can impact performance.
The virtual machines disk size cannot be changed if any snapshot is taken from the virtual
machine. Any existing snapshots must be deleted first.

• OVA Deployment
• Soft Power Off
• High Availability: Enables the automatic re-establishment of the virtual machine on a new

host server during a failure on or of the original host. See High availability on page 26.
• VMware Tools: Note however that an IP Office specific version of VMware tools is included as

part of the IP Office OVA. See VMware tools on page 13.

vSphere Clients
Traditional host management used the vSphere desktop client installed on a client PC. For vSphere
5.0 onwards, VMware introduced the vSphere web client. The vSphere desktop client is still
supported, however new features released with vSphere 5.1 and higher are only managed using the
vSphere web client.
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Also, using vSphere desktop client to connect to the ESXi 5.5 host and deploy the OVA will fail.
When the 5.x ESXi host version is managed by a virtual center, the vSphere desktop client's
management capabilities are restricted.

Related links
Hardware, software and virtual machine requirements on page 23
vMotion requirements on page 24
Disk IOPS requirements on page 24
Alarms on page 25
High availability on page 26

Hardware, software and virtual machine requirements
Refer to the following:

• For a searchable list of hardware platforms, refer to VMware Compatibility Guide. The
platform must support at least 2 Ethernet interfaces.

• ESXi Hardware Requirements.

• VMware Lifecycle Product Matrix for current supported VMware software.

Avaya provides IP Office virtualization software in an OVA format. The following are high-level
software and hardware requirements:

• Latest VMware vSphere software. See VMware Features on page 22.

• VMware vSphere desktop client software. vCenter is supported but not required unless using
vSphere web client.

• VMware compatible hardware platform.

• Intel-based CPUs from the Xeon family with 2 GHz clock speed or better. 2.4 GHz
recommended.

• The RAM size must satisfy the ESXi requirements in addition to the specific RAM
requirements of the virtual machines deployed. The profiling section lists the requirements for
IP Office virtual machines. 6 GB and higher is recommended.

• 2 Ethernet interfaces (more recommended if using vMotion)

To determine the required virtual server platform:

• Refer to the Default virtual machine on page 16 section to assess the total requirements for
the IP Office virtual machines.

• Add in the requirements for any other virtual machines.

• Add in the underlying requirements for the virtual server software itself.

• Note the minimum requirements above.

• Note the requirements for vMotion. See vMotion requirements on page 24.

Hardware, software and virtual machine requirements
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• Assess the compatibility of potential server platforms using the VMware site.

Related links
VMware Features on page 22

vMotion requirements
vMotion allows you to move an existing virtual machine from one virtual server platform to another
with minimal interruption to the operation of the virtual machine. For example, this may be
necessary if the existing server platform resources become exhausted.

For IP Office virtual machines, using vMotion allows you to move the virtual machine without
changing its System Identification and requiring new IP Office licenses. If the virtual machine is
running one-X Portal, any existing sessions may have to log in again after the move.

To use vMotion:

• Each server platform requires 2 Gigabit Ethernet ports with one port dedicated to vMotion
traffic.

• The server platform CPUs must be similar, that is, from the same manufacturer and using
similar processor architectures.

• The Ethernet switch connecting the two servers must be minimum 10Gbps.
• vMotion imposes specific storage requirements. Several options exist including iSCSI and

local storage, among others. See VMware vMotion documentation for detailed requirements.
• To decrease chances of one-X Portal connectivity interruptions, it is recommended that

vMotion operation is done at times of low IP Office use.

Related links
VMware Features on page 22

Disk IOPS requirements
Input/Output Operations Per Second (IOPS) is a measurement of the traffic between a virtual
machine and the disk storage it is using. The following factors should be considered when
assessing the IOPS aspect of the virtual platform:

• The number of virtual machines running on an ESXi host should not exceed the IOPS of the
disk storage divided by 30. For example, a datastore with an IOPS of 150 should only
support up to 5 virtual machines.

• The total maximum IOPS of all the virtual machines must be within the IOPS capacity of the
datastore. To compute how many IOPS the storage supports, you need to know the hard disk
type, RAID configuration, number of drives, connection method, and so on. See Poor
performance and high disk latency with some storage configurations

VMware Features
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• By default, no IOPS limit is set for each virtual machine disk. If limits are set, it is important to
understand how the limits are used for all virtual machines using the same datastore. The
limits are aggregated to set an overall limit for the datastore as follows:

- Example: 4 virtual machine disks using the same datastore, each disk set to 100 IOPS.

• As each disk is limited to 100, the total IOPS for the datastore is 400. If disks 1, 2 and 3
are currently using 10 IOPS each, disk 4 could use 370 IOPS without being restricted.

- Example: One disk set to Unlimited (the default), all other disks are set to 100 IOPS.

• As one of the disks is set to unlimited, the potential IOPS for the virtual machine disks
using that datastore are also unlimited.

Exceeding the IOPS capacity of the datastore will lead to unpredictable results for virtual machine
applications using that storage. Whilst a maximum IOPS limit can be applied to each virtual
machine disk, that approach is not recommended for IP Office virtual machines as once again it
will lead to unpredictable behavior.

Related links
VMware Features on page 22

Alarms
The vSphere clients Performance tab displays performance information for individual virtual
machines and for the whole ESXi server. vCenter further extends the capabilities of monitoring this
performance on long term basis.

In addition to the above performance monitors for any virtual machines, for IP Office virtual
machines a number of specific alarms are available that can be output to other applications. The
alarms are warning alarms, critical alarms and OK alarms for when usage returns to below the
alarm threshold.

Alarm Alarm Threshold
Warning Alarm Critical Alarm

CPU Clock Cycles 90% 95%
RAM Memory 85% 97%
Hard Disk Input/Output 15% 25%
Network 15% 25%

You can view and or receive the alarms in a number of ways:

• They appear in the alarms shown by the server's web control menus. see Server Edition
documentation.

• Within the configuration of the IP Office application on the virtual machine, you can select to
output alarms to SNMP, Syslog and or email. IP Office Manager manual.

Alarms
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• System Status Application displays the alarms when connected to the virtual machine.

Related links
VMware Features on page 22

High availability
VMware High Availability (HA) allows a virtual machine to be automatically re-established on
another host machine if its normal host fails or detects a potential failure. For example:

• Host failures include power failure and ESXi kernel panic.

• A Linux operating system crash on the host server.

Backup is started up after a failure has been detected and takes a approximately 10 minutes to
complete. During the switch any unsaved data and active calls are lost.

Use of this feature is only supported for IP Office Select systems. It requires the customer data
center to include multiple host servers and for those hosts to have access to the same separate
datastore.

HA cannot be combined with IP Office resiliency as the two mechanisms conflict. For example, if
HA is enabled for a Primary Server, no primary resources (phones, hunt groups, voicemail server)
can be supported using IP Office resilience fallback to a Secondary Server.

Related links
VMware Features on page 22

VMware Features
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Chapter 6: VMware deployment

This section outlines the steps required to deploy an IP Office server as a virtual machine. If
deploying several virtual machines, the order of deployment and configuration is the same as per
the Server Edition deployment documentation. see Related Documentation on page 8.

In addition to certified IP Office training, the installer and system maintainer must have certified
training on the specific virtual platform type or supported by someone who has the required
certification.

During deployment, you must ensure that the deployment of oneIP Office virtual machine has
completed, including setting the LAN1 and LAN2 IP addresses to the required values, before
starting the deployment of any other IP Office virtual machine.

Related links
Confirm the system settings on page 27
Downloading software on page 28
Deploying the VMware OVA file (vSphere web client) on page 29
Deploying the VMware OVA file (vSphere desktop client) on page 30
Adding an additional VMware hard disk on page 30
Virtual machine profiling on page 32
Powering On a VMware virtual machine on page 44

Confirm the system settings
Any duplication of IP addresses, even the temporary default IP addresses, causes the IP Office
application to not start and any existing IP Office service to stop.

If using local nodal licensing (see Virtual server licensing on page 10), the virtual server bases the
PLDS Host ID its uses for license validation on several server configuration settings. Hence,
before deploying the virtual machine and obtaining any licenses, you must confirm with the
customer the final values for the following:

• Host Name

• LAN1 IP Address

• LAN2 IP Address

• Timezone

October 2021 Deploying Avaya IP Office Servers as Virtual Machines 27
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Deploying Avaya IP Office Servers as Virtual Machines


• DHCP Mode

This does not apply if using WebLM centralized licensing.

Related links
VMware deployment on page 27
Hyper-V deployment on page 46

Downloading software
About this task
Avaya make a number of different file available for each IP Office release. For a VMware
deployment, select the following files:

• OVA file: You use this type of file for the initial deployment of a VMware virtual machine. The
file is an full machine image.

• TTS ISO: The images used to deploy new virtual machines do not include text-to-speech
(TTS) prompts. To add TTS languages, you need to download and install the additional ISO
files for TTS languages. These are provided as 3 ISO files:
- DVD 1: English, Spanish, French, German, Italian.
- DVD 2: Swedish, Norwegian, Finnish, Dutch, Danish, Portuguese, Greek.
- DVD 3: Chinese, Polish, Russian.

Procedure
1. Browse to http://support.avaya.com and log in.

2. Click Support by Product and select Downloads.

3. In the Enter Product Name box, enter IP Office and select the displayed match.

4. Use the Choose Release drop-down to select the required release.

5. From the listed Downloads, select the particular version of the release required (there
may be multiple versions of a release depending on the number of service and feature
packs that have been made available).

6. Click on the required files and follow any further instructions shown by the website and
your browser..

7. Also download and read any documents shown under Related Documents
Next steps

• Proceed to deploying the new virtual machine using the VMware desktop client (see 
Deploying the VMware OVA file (vSphere desktop client) on page 30) or web client (see 
Deploying the VMware OVA file (vSphere web client) on page 29).

Related links
VMware deployment on page 27

VMware deployment
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Deploying the VMware OVA file (vSphere web client)
About this task
Deploying the OVA file to the virtual server platform creates a new virtual machine. Note that,
depending on the speed of the link between the client PC and the virtual server host, this process
can take several hours.

Procedure
1. Using the vSphere Web Client, connect to the host server onto which you want to deploy

the OVA.

2. Select Action > All vCenter Actions > Deploy OVF Template.

3. Enter the location of the OVA file. If on your PC, click Browse, select the OVA image file
and click Open and then click Next.

4. A summary of the OVA is displayed. Click Next.
5. The installer displays the license agreement. Click Accept and then click Next.
6. Enter a name for the virtual machine. This name appears in the VMware server inventory

of virtual machines it is hosting. Click Next.
7. Set the type of disk space usage to Thick Provision Eager Zeroed. Also select the

datastore that the virtual machine should use. Click Next.
8. Select the network connections for the virtual machine. The virtual interfaces should not be

on the same LAN. Click Next.
9. Set the network addresses for the network interfaces. Click Next.

10. The install wizard displays a summary of the deployment settings. Do not select Power on
after deployment check box.

11. Click Finish.

Next steps
Once the deployment is complete, the new virtual machine appears in the inventory of virtual
machines.

• If deploying a virtual machine to run Media Manager, you now need to add an additional hard
disk. See Adding an additional VMware hard disk on page 30.

• Otherwise, you can now adjust the resource allocation of the virtual machine. See Virtual
machine profiling on page 32.

Related links
VMware deployment on page 27

Deploying the VMware OVA file (vSphere web client)
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Deploying the VMware OVA file (vSphere desktop client)
About this task
Deploying the OVA file to the virtual server platform creates a new virtual machine. Note that,
depending on the speed of the link between the client PC and the virtual server host, this process
can take several hours.

Procedure
1. Using the VMware vSphere Client, connection go virtual server.

2. Select File and then select Deploy OVF TemplateDeploy OVF Template.

3. Click Browse and select the OVA image file and click Open and click Next.

4. The installer displays the license agreement. Click Accept and then click Next.
5. Enter a name for the virtual machine. This name appears in the VMware server inventory

of virtual machines it is hosting. Click Next.
6. Set the type of disk space usage to Thick Provision Eager Zeroed. Also select the

datastore that the virtual machine should use. Click Next.
7. Select the network connections for the virtual machine. The virtual interfaces should not be

on the same LAN. Click Next.
8. Set the network addresses for the network interfaces. Click Next.
9. The install wizard displays a summary of the deployment settings. Do not select Power on

after deployment check box.

10. Click Finish.

Next steps
Once the deployment is complete, the new virtual machine appears in the inventory of virtual
machines.

• If deploying a virtual machine to run Media Manager, you now need to add an additional hard
disk. See Adding an additional VMware hard disk on page 30.

• Otherwise, you can now adjust the resource allocation of the virtual machine. See Virtual
machine profiling on page 32.

Related links
VMware deployment on page 27

Adding an additional VMware hard disk
To run the Media Manager application on the same IP Office server as Voicemail Pro, it must be
provided with and configured to use an additional hard disk. This requirement applies even is
running on a virtual machine. This process must be performed before initial server ignition.

VMware deployment
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The minimum supported size is 30 GB. However, the recommended size is 300 GB or higher.
Remember that for a virtual machine installation of Media Manager, archiving to Blu-Ray/DVD disk
is not supported. See Media Manager archiving on page 13.

• Media Manager typically requires 60 KB per minute for non-authenticated files and 120 KB
per minute for authenticated files.

• Media Manager also reserves 1 GB of space for the call details database and other
operations.

Related links
VMware deployment on page 27
Adding an additional VMware hard disk (vSphere web client) on page 31
Adding an additional VMware hard disk (vSphere desktop client) on page 31

Adding an additional VMware hard disk (vSphere web client)
Procedure

1. Using the vSphere web client, select the virtual machine. For example, select vCenter
Management and in the navigation tree on the left select the virtual machine.

2. Right-click a virtual machine in the inventory and select Edit Settings.

3. On the Virtual Hardware tab, from the New device drop-down select New Hard Disk and
click Add. The hard disk appears in the virtual hardware devices list.

4. Expand New hard disk.

5. Set the hard disk size and select the units (MB or GB) from the drop-down menu.

6. Select the datastore location where you want to store the virtual machine files.

7. For the format select Thick Provision Eager Zeroed and click Next.
Next steps

• You should now adjust the resource allocation of the virtual machine. See Virtual machine
profiling on page 32.

Related links
Adding an additional VMware hard disk on page 30

Adding an additional VMware hard disk (vSphere desktop client)
Procedure

1. Using the vSphere desktop client, select the Inventory view.

2. Locate the required virtual machine in the inventory navigation tree on the left. If not
shown, select View > Show VMs in Inventory.

3. Click on the virtual machine.

Adding an additional VMware hard disk
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4. Right-click on the virtual machine and select Edit Settings.

5. On the Virtual Hardware tab, click on Add and select Hard Disk and click Next
6. Select Create a new virtual disk and click Next.
7. Set the Disk Size.

8. Set the Disk Provisioning to Thick Provision Eager Zeroed.

9. Select the Datastore to use. This can be the same datastore or a different one from that
used during the OVA deployment.

10. Click Next.
11. Check the settings are as required. Click Finish.

Next steps
• You should now adjust the resource allocation of the virtual machine. See Virtual machine

profiling on page 32.
Related links

Adding an additional VMware hard disk on page 30

Virtual machine profiling
After deploying a virtual machine, you should optimize its allocated resources to meet the
requirements of the virtual machine’s role, see Profiling on page 15. For example, if the virtual
machine will only support 50 users, you can reduce the allocated processors and RAM memory.
This allows for the best use of the overall resources provided by the virtual server platform.

Attribute Description
Memory You can set the maximum amount of RAM memory that the virtual machine can use. You

can also set how much of that RAM memory the platform guarantees for the virtual
machine.

See Adjusting the VMware RAM memory on page 34
CPU You can configure multiple virtual processor (vCPUs) for a virtual machine. A virtual

machine cannot have more vCPUs than the maximum number of logical CPUs on the host
virtual server platform. The number of logical CPUs is the number of physical processor
cores.

See Adjusting the VMware CPU Cores on page 36
Table continues…

VMware deployment
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Attribute Description
CPU Clock
Cycles

You can set the maximum number of CPU clock cycles that the virtual machine can use.
You can also set the number of CPU clock cycles guaranteed for the virtual machine.
Multiply the clock cycle of the CPU with the number of allocated virtual CPU processors to
determine the aggregate value and compare it with recommended profiling values.

See Adjusting the VMware CPU Cycles on page 37
Hard Disk By default the virtual machine is allocated a 100 GB virtual disk. However, this can be

increased if required. Note however that the size cannot be decreased at a later stage.

See Adjusting the VMware disk space on page 39.
IOPS Input/Output Operations Per Second (IOPS) is a measurement of the traffic between a

virtual machine and the disk storage it is using.

See Disk IOPS requirements on page 24
Network
Ports

The IP Office virtual machine deploys with two network interfaces. By default these
configure as LAN1 (192.168.42.1/255.255.255.0) and LAN2 (192.168.43.1/255.255.255.0)
when the virtual machine starts. If the LAN2 port is not required, it can be disabled, see 
Disabling a VMware network port on page 42. This reduces the chances of IP address
duplication which causes the IP Office application to not start, see Duplicate IP address
issue on page 7.

After profiling, you can power on the virtual machine. See Powering On a VMware virtual
machine on page 44.

• Profiling Other Virtual Machines: It is good practice to monitor the resource utilization of all
the virtual machines running in their infrastructure. Profile all virtual machines running on the
virtual server platform to fine-tune the hardware resources allocated and used. This will
improve performance by allocating resources where they are needed and optimize the use of
their virtual infrastructure.

• Multiple IP Office Servers: If deploying servers with the intention of using resiliency, then
the hardware resources and profiling applied to each server must include allowance for the
scenarios where users re-register from one server to the other, effectively increasing the
server's user requirements. If there is a mix of non-virtualized and virtualized machines, then
the assignment of resources to the virtual machine must match the hardware resources
available in the non-virtualized machine.

Related links
VMware deployment on page 27
Adjusting the VMware RAM memory on page 34
Adjusting the VMware CPU Cores on page 36
Adjusting the VMware CPU Cycles on page 37
Adjusting the VMware disk space on page 39
Adjusting the VMware IOPS limits on page 40
Disabling a VMware network port on page 42

Virtual machine profiling

October 2021 Deploying Avaya IP Office Servers as Virtual Machines 33
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Deploying Avaya IP Office Servers as Virtual Machines


Adjusting the VMware RAM memory
You can set the maximum amount of RAM memory that the virtual machine can use. You can also
set how much of that RAM memory the platform guarantees for the virtual machine. Set these
values to match the virtual server’s profile requirements. See Profiling on page 15.

Warning:
• The following processes can be used on a new virtual machine that has not been

powered on/started.

• To perform the same actions on an existing virtual machine, it must first be powered off/
stopped before making the adjusting and then powered on/started again. That will
interrupt all services provided by the virtual machine.

Related links
Virtual machine profiling on page 32
Adjusting the VMware RAM memory (vSphere web client) on page 34
Adjusting the VMware RAM memory (vSphere desktop client) on page 35

Adjusting the VMware RAM memory (vSphere web client)
Procedure

1. Using the vSphere web client, select the virtual machine. For example, select vCenter
Management and in the navigation tree on the left select the virtual machine.

2. Right-click a virtual machine in the inventory and select Edit Settings.

3. Expand the Memory.

4. In the RAM text box, type the amount of RAM to assign to the virtual machine. See 
Profiling on page 15. Select whether the memory is specified in MB or GB.

5. Select the required values for reservations and shares:

• Reservation – This value sets the guaranteed minimum available RAM for the virtual
machine. You cannot set the reservation higher than the maximum memory value. For
IP Office virtual machines, the recommended value is 75-80% of the maximum.

• Shares – Select the virtual machine's relative priority for sharing the server platform
memory. The values are Low, Normal, High and Custom. The more shares a virtual
machine has, the more often it gets a time slice of a memory when there is no memory
idle time. Shares represent a relative priority for the allocation of memory capacity
between virtual machines. For more information about share values, refer to the
VMware Resource Management Guide.

Select Normal only if the IP Office virtual machine has exclusive use of the ESXi host.
However, if other virtual machines utilizing the share mechanism present on the host, it
is imperative that IP Office virtual machine is set to High. IP Office is a real-time
telecommunication software that requires immediate access to hardware resources.

VMware deployment
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6. Click OK.

Next steps
• If doing as part of installing a new virtual machine, continue with any further profiling required.

When completed, start the virtual machine (see Powering On a VMware virtual machine on
page 44).

Related links
Adjusting the VMware RAM memory on page 34

Adjusting the VMware RAM memory (vSphere desktop client)
Procedure

1. Using the vSphere desktop client, select the Inventory view.

2. Locate the required virtual machine in the inventory navigation tree on the left. If not
shown, select View > Show VMs in Inventory.

3. Click on the virtual machine.

4. Right-click on the virtual machine and select Edit Settings.

5. Select Memory.

6. Adjust the maximum memory size for the virtual machine. See Profiling on page 15.

7. Click the Resources tab and select Memory. Allocate the RAM for the virtual machine.
See Profiling on page 15.

• Reservation – This value sets the guaranteed minimum available RAM for the virtual
machine. You cannot set the reservation higher than the maximum memory value. For
IP Office virtual machines, the recommended value is 75-80% of the maximum.

• Shares – Select the virtual machine's relative priority for sharing the server platform
memory. The values are Low, Normal, High and Custom. The more shares a virtual
machine has, the more often it gets a time slice of a memory when there is no memory
idle time. Shares represent a relative priority for the allocation of memory capacity
between virtual machines. For more information about share values, refer to the
VMware Resource Management Guide.

Select Normal only if the IP Office virtual machine has exclusive use of the ESXi host.
However, if other virtual machines utilizing the share mechanism present on the host, it
is imperative that IP Office virtual machine is set to High. IP Office is a real-time
telecommunication software that requires immediate access to hardware resources.

8. Click OK.

Next steps
• If doing as part of installing a new virtual machine, continue with any further profiling required.

When completed, start the virtual machine (see Powering On a VMware virtual machine on
page 44).

Related links
Adjusting the VMware RAM memory on page 34

Virtual machine profiling
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Adjusting the VMware CPU Cores
You can configure multiple virtual processor (vCPUs) for a virtual machine. A virtual machine
cannot have more vCPUs than the maximum number of logical CPUs on the host virtual server
platform. The number of logical CPUs is the number of physical processor cores.

Note that the CPU core clock speed affects the range selection. When the CPU is at the low end
toward 2 GHz, use the higher number of CPUs. When the CPU speed is higher, for example 3.6
GHz, use the lower number of CPUs.

The CPU core clock speed multiplied by the number of cores, must meet the aggregate CPU cycle
requirements of the virtual machine. See Profiling on page 15.

Related links
Virtual machine profiling on page 32
Adjusting the VMware CPU Cores (vSphere web client) on page 36
Adjusting the VMware CPU Cores (vSphere desktop client) on page 36

Adjusting the VMware CPU Cores (vSphere web client)
Procedure

1. Using the vSphere web client, select the virtual machine. For example, select vCenter
Management and in the navigation tree on the left select the virtual machine.

2. Right-click a virtual machine in the inventory and select Edit Settings.

3. Expand the CPU.

4. Select the number of virtual processors for the virtual machine. See Profiling on page 15

5. Click OK.

Next steps
• If doing as part of installing a new virtual machine, continue with any further profiling required.

When completed, start the virtual machine (see Powering On a VMware virtual machine on
page 44).

Related links
Adjusting the VMware CPU Cores on page 36

Adjusting the VMware CPU Cores (vSphere desktop client)
Procedure

1. Using the vSphere desktop client, select the Inventory view.

2. Locate the required virtual machine in the inventory navigation tree on the left. If not
shown, select View > Show VMs in Inventory.

3. Click on the virtual machine.

4. Right-click on the virtual machine and select Edit Settings.
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5. Click the Hardware tab and select CPU.

6. Select the number of virtual processors for the virtual machine. See Profiling on page 15

7. Click OK.

Next steps
• If doing as part of installing a new virtual machine, continue with any further profiling required.

When completed, start the virtual machine (see Powering On a VMware virtual machine on
page 44).

Related links
Adjusting the VMware CPU Cores on page 36

Adjusting the VMware CPU Cycles
You can set the maximum number of CPU clock cycles that the virtual machine can use. You can
also set the number of CPU clock cycles guaranteed for the virtual machine.

Multiply the clock cycle of the CPU with the number of allocated virtual CPU processors to
determine the aggregate value and compare it with recommended profiling values. See 
Profiling on page 15.

Related links
Virtual machine profiling on page 32
Adjusting the VMware CPU Cycles (vSphere web client) on page 37
Adjusting the VMware CPU Cycles (vSphere desktop client) on page 38

Adjusting the VMware CPU Cycles (vSphere web client)
Procedure

1. Using the vSphere web client, select the virtual machine. For example, select vCenter
Management and in the navigation tree on the left select the virtual machine.

2. Right-click a virtual machine in the inventory and select Edit Settings.

3. On the Virtual Hardware tab, expand CPU.

4. Allocate the CPU cycles for the virtual machine's vCPUs. See Profiling on page 15

• Reservation – This value sets the guaranteed minimum available RAM for the virtual
machine. You cannot set the reservation higher than the maximum memory value. For
IP Office virtual machines, the recommended value is 75-80% of the maximum.

• Shares – The more shares a virtual machine has, the more often it gets a time slice of a
CPU when there is no CPU idle time. Shares represent a relative priority for the
allocation of memory capacity between virtual machines. For more information about
share values, refer to the VMware Resource Management Guide.

- Select Normal only if the IP Office virtual machine has exclusive use of the ESXi
host. However, if other virtual machines utilizing the share mechanism present on the
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host, it is imperative that IP Office virtual machine is set to High. IP Office is a real-
time telecommunication software that requires immediate access to hardware
resources.

5. Click OK.

Next steps
• If doing as part of installing a new virtual machine, continue with any further profiling required.

When completed, start the virtual machine (see Powering On a VMware virtual machine on
page 44).

Related links
Adjusting the VMware CPU Cycles on page 37

Adjusting the VMware CPU Cycles (vSphere desktop client)
Procedure

1. Using the vSphere desktop client, select the Inventory view.

2. Locate the required virtual machine in the inventory navigation tree on the left. If not
shown, select View > Show VMs in Inventory.

3. Click on the virtual machine.

4. Right-click on the virtual machine and select Edit Settings.

5. Click the Resources tab and select CPU.

6. Allocate the CPU cycles for the virtual machine's vCPUs. See Profiling on page 15

• Reservation – This value sets the guaranteed minimum available RAM for the virtual
machine. You cannot set the reservation higher than the maximum memory value. For
IP Office virtual machines, the recommended value is 75-80% of the maximum.

• Shares – The more shares a virtual machine has, the more often it gets a time slice of a
CPU when there is no CPU idle time. Shares represent a relative priority for the
allocation of memory capacity between virtual machines. For more information about
share values, refer to the VMware Resource Management Guide.

- Select Normal only if the IP Office virtual machine has exclusive use of the ESXi
host. However, if other virtual machines utilizing the share mechanism present on the
host, it is imperative that IP Office virtual machine is set to High. IP Office is a real-
time telecommunication software that requires immediate access to hardware
resources.

7. Click OK.

Next steps
• If doing as part of installing a new virtual machine, continue with any further profiling required.

When completed, start the virtual machine (see Powering On a VMware virtual machine on
page 44).

Related links
Adjusting the VMware CPU Cycles on page 37
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Adjusting the VMware disk space
By default the virtual machine is allocated a 100 GB virtual disk. However, this can be increased to
meet the virtual server’s profiling requirements. See Profiling on page 15.

Note however:

• The disk size cannot be decreased at a later stage.

• The virtual machines disk size cannot be changed if any snapshot have been taken of the
virtual machine. Any existing snapshots must first be deleted.

The process for increasing the disk size takes two parts:

• Using a vSphere client, increase the virtual machine's disk size and then restart the virtual
machine.

• Using the server's IP Office web management menus, indicate to use the additional space
and restart the server.

Related links
Virtual machine profiling on page 32
Adjusting the VMware disk space (vSphere web client) on page 39
Adjusting the VMware disk space (vSphere desktop client) on page 40

Adjusting the VMware disk space (vSphere web client)
Procedure

1. Using the vSphere web client, select the virtual machine. For example, select vCenter
Management and in the navigation tree on the left select the virtual machine.

2. Right-click a virtual machine in the inventory and select Edit Settings.

3. Click the Hardware tab and select the hard disk to modify.

4. Select a Virtual Device Node type from the drop-down menu.

5. To change the size of the disk, enter a new value in the Provisioned Size text box. See 
Profiling on page 15.

6. Click OK.

7. Right-click on the virtual machine and select Power > Power Off.
Next steps

• If doing as part of installing a new virtual machine, continue with any further profiling required.
When completed, start the virtual machine (see Powering On a VMware virtual machine on
page 44).

Related links
Adjusting the VMware disk space on page 39
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Adjusting the VMware disk space (vSphere desktop client)
Procedure

1. Using the vSphere desktop client, select the Inventory view.

2. Locate the required virtual machine in the inventory navigation tree on the left. If not
shown, select View > Show VMs in Inventory.

3. Click on the virtual machine.

4. Right-click on the virtual machine and select Edit Settings.

5. Click the Hardware tab and select the hard disk to modify.

6. Select a Virtual Device Node type from the drop-down menu.

7. To change the size of the disk, enter a new value in the Provisioned Size text box. See 
Profiling on page 15.

8. Click OK.

9. Right-click on the virtual machine and select Power > Power Off.
Next steps

• If doing as part of installing a new virtual machine, continue with any further profiling required.
When completed, start the virtual machine (see Powering On a VMware virtual machine on
page 44).

Related links
Adjusting the VMware disk space on page 39

Adjusting the VMware IOPS limits
Input/Output Operations Per Second (IOPS) is a measurement of the traffic between a virtual
machine and the disk storage it is using.

The following factors should be considered when assessing the IOPS aspect of the virtual
platform:

• The number of virtual machines running on an ESXi host should not exceed the IOPS of the
disk storage divided by 30. For example, a datastore with an IOPS of 150 should only
support up to 5 virtual machines.

• The total maximum IOPS of all the virtual machines must be within the IOPS capacity of the
datastore. To compute how many IOPS the storage supports, you need to know the hard disk
type, RAID configuration, number of drives, connection method, and so on. See VMware
Knowledge Base.

• By default no IOPS limit is set for each virtual machine disk. However, an IOPS limit can be
set. If limits are set, it is important to understand how the limits are used for all virtual
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machines using the same datastore. The limits are aggregated to set an overall limit for the
datastore as follows:

- Example: 4 virtual machine disks using the same datastore and each disk set to 100 IOPS
As each disk is limited to 100, the total IOPS for the datastore is 400. If disks 1, 2 and 3
are currently using 10 IOPS each, disk 4 could use 370 IOPS without being restricted.

- Example: One disk set to Unlimited (the default), all other disks are set to 100 IOPS As
one of the disks is set to unlimited, the potential IOPS for the virtual machine disks using
that datastore are also unlimited.

Exceeding the IOPS capacity of the datastore will lead to unpredictable results for virtual machine
applications using that storage. Whilst a maximum IOPS limit can be applied to each virtual
machine disk, that approach is not recommended for IP Office virtual machines as once again it
will lead to unpredictable behavior.

Warning:
• The following processes can be used on a new virtual machine that has not been

powered on/started.

• To perform the same actions on an existing virtual machine, it must first be powered off/
stopped before making the adjusting and then powered on/started again. That will
interrupt all services provided by the virtual machine.

Related links
Virtual machine profiling on page 32
Adjusting the VMware IOPS limits (vSphere web client) on page 41
Adjusting the VMware IOPS limits (vSphere desktop client) on page 42

Adjusting the VMware IOPS limits (vSphere web client)
Procedure

1. Using the vSphere web client, select the virtual machine. For example, select vCenter
Management and in the navigation tree on the left select the virtual machine.

2. Right-click a virtual machine in the inventory and select Edit Settings.

3. Click the Virtual Hardware tab and expand Hard Disk.

4. Select a virtual hard disk from the list.

5. Under Shares, click the drop-down menu and select the relative amount of shares to
allocate to the virtual machine (Low, Normal or High). You can select Custom to enter a
user-defined shares value. Higher shares allow a virtual machine to keep more concurrent
I/O operations pending at the storage device or datastore compared to a virtual machine
with lower shares.

6. Under Limit — IOPS, click the drop-down menu and enter the upper limit of storage
resources to allocate to the virtual machine. By default, IOPS are unlimited. You can
selectLow (500), Normal (1000), or High (2000), or you can select Custom to enter a
user-defined number of shares.
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7. Click OK.

Next steps
• If doing as part of installing a new virtual machine, continue with any further profiling required.

When completed, start the virtual machine (see Powering On a VMware virtual machine on
page 44).

Related links
Adjusting the VMware IOPS limits on page 40

Adjusting the VMware IOPS limits (vSphere desktop client)
Procedure

1. Using the vSphere desktop client, select the Inventory view.

2. Locate the required virtual machine in the inventory navigation tree on the left. If not
shown, select View > Show VMs in Inventory.

3. Click on the virtual machine.

4. Click the Resources tab.

5. Select Hard Disk.

6. In Limit — IOPS set the required IOPS limit for each disk the virtual machine uses. See 
Profiling on page 15. By default, the limits are set to Unlimited.

7. Click OK.

Next steps
• If doing as part of installing a new virtual machine, continue with any further profiling required.

When completed, start the virtual machine (see Powering On a VMware virtual machine on
page 44).

Related links
Adjusting the VMware IOPS limits on page 40

Disabling a VMware network port
The IP Office virtual machine deploys with two network interfaces. By default these configure as
LAN1 (192.168.42.1/255.255.255.0) and LAN2 (192.168.43.1/255.255.255.0) when the virtual
machine starts. If the LAN2 port is not required, it can be disabled. This reduces the chances of IP
address duplication which causes the IP Office application to not start, see Duplicate IP address
issue on page 7.

Warning:
• The following processes can be used on a new virtual machine that has not been

powered on/started.
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• To perform the same actions on an existing virtual machine, it must first be powered off/
stopped before making the adjusting and then powered on/started again. That will
interrupt all services provided by the virtual machine.

Related links
Virtual machine profiling on page 32
Disabling a VMware network port (vSphere web client) on page 43
Disabling a VMware network port (vSphere desktop client) on page 43

Disabling a VMware network port (vSphere web client)
Before you begin

• The following processes can be used on a new virtual machine that has not been powered
on/started.

• To perform the same actions on an existing virtual machine, it must first be powered off/
stopped before making the adjusting and then powered on/started again. That will interrupt all
services provided by the virtual machine.

Procedure
1. Using the vSphere web client, select the virtual machine. For example, select vCenter

Management and in the navigation tree on the left select the virtual machine.

2. Right-click a virtual machine in the inventory and select Edit Settings.

3. Select NIC 2.

4. Deselect Connect at power on.

5. Click OK.

Next steps
• If doing as part of installing a new virtual machine, continue with any further profiling required.

When completed, start the virtual machine (see Powering On a VMware virtual machine on
page 44).

Related links
Disabling a VMware network port on page 42

Disabling a VMware network port (vSphere desktop client)
Before you begin

• The following processes can be used on a new virtual machine that has not been powered
on/started.

• To perform the same actions on an existing virtual machine, it must first be powered off/
stopped before making the adjusting and then powered on/started again. That will interrupt all
services provided by the virtual machine.

Procedure
1. Using the vSphere desktop client, select the Inventory view.
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2. Locate the required virtual machine in the inventory navigation tree on the left. If not
shown, select View > Show VMs in Inventory.

3. Click on the virtual machine.

4. Right-click on the virtual machine and select Edit Settings.

5. Select NIC 2.

6. Deselect Connect at power on.

7. Click OK.

Next steps
• If doing as part of installing a new virtual machine, continue with any further profiling required.

When completed, start the virtual machine (see Powering On a VMware virtual machine on
page 44).

Related links
Disabling a VMware network port on page 42

Powering On a VMware virtual machine
About this task
Following profiling of the virtual machine, you can power on the virtual server.

Procedure
1. Right-click on the virtual machine.

2. Select Power > Power On.

Next steps
• You can now use a web browser to access the virtual machine. See Connecting to the

uninitialized virtual machine on page 71.
• As part of the deployment of a new virtual machine, you now need to complete the initial

server configuration processes.
Related links

VMware deployment on page 27
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Part 3: Microsoft Hyper-V
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Chapter 7: Hyper-V deployment

IP Office server's are supported as Hyper-V virtual machines.

• Supported virtual machine platforms are Hyper-V running on Windows 2012 R2 and Windows
2016 servers and Microsoft Hyper-V Server 2012 R2 and 2016.

• The installation is performed using a Hyper-V disk image file (VHDX) downloaded from the
Avaya support website.

• Virtual Server Edition/IP Office Select servers require Virtualized Server licenses. See Virtual
server licensing on page 10.

This section outlines the steps required to deploy an IP Office server as a virtual machine. If
deploying several virtual machines, the order of deployment and configuration is the same as per
the Server Edition deployment documentation. see Related Documentation on page 8.

In addition to certified IP Office training, the installer and system maintainer must have certified
training on the specific virtual platform type or supported by someone who has the required
certification.

During deployment, you must ensure that the deployment of oneIP Office virtual machine has
completed, including setting the LAN1 and LAN2 IP addresses to the required values, before
starting the deployment of any other IP Office virtual machine.

Related links
Confirm the system settings on page 27
Downloading the software on page 47
Copying and renaming the disk image file on page 48
Expanding the file hard disk size on page 48
Creating a new Hyper-V virtual machine on page 49
Adding an additional hard disk on page 50
Hyper-V virtual machine profiling on page 51
Starting the virtual machine on page 54

Confirm the system settings
Any duplication of IP addresses, even the temporary default IP addresses, causes the IP Office
application to not start and any existing IP Office service to stop.
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If using local nodal licensing (see Virtual server licensing on page 10), the virtual server bases the
PLDS Host ID its uses for license validation on several server configuration settings. Hence,
before deploying the virtual machine and obtaining any licenses, you must confirm with the
customer the final values for the following:

• Host Name

• LAN1 IP Address

• LAN2 IP Address

• Timezone

• DHCP Mode

This does not apply if using WebLM centralized licensing.

Related links
VMware deployment on page 27
Hyper-V deployment on page 46

Downloading the software
About this task
Avaya make a number of different file available for each IP Office release. For a Hypervisor
deployment, select the following files:

• VHDX file: (Hypervisor) This file is actually downloaded as a zipped file from which you can
then extract the .vhdx file. The file is a hard disk image. In the process of creating a new
virtual machine, the file becomes the virtual machine's hard disk.

• TTS ISO: The images used to deploy new virtual machines do not include text-to-speech
(TTS) prompts. To add TTS languages, you need to download and install the additional ISO
files for TTS languages. These are provided as 3 ISO files:
- DVD 1: English, Spanish, French, German, Italian.
- DVD 2: Swedish, Norwegian, Finnish, Dutch, Danish, Portuguese, Greek.
- DVD 3: Chinese, Polish, Russian.

Procedure
1. Browse to http://support.avaya.com and log in.

2. Click Support by Product and select Downloads.

3. In the Enter Product Name box, enter IP Office and select the displayed match.

4. Use the Choose Release drop-down to select the required release.

5. From the listed Downloads, select the particular version of the release required (there
may be multiple versions of a release depending on the number of service and feature
packs that have been made available).

Downloading the software
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6. Click on the required files and follow any further instructions shown by the website and
your browser..

7. Also download and read any documents shown under Related Documents
Next steps

• Copy and rename the VHDX file. See Copying and renaming the disk image file on page 48.
Related links

Hyper-V deployment on page 46

Copying and renaming the disk image file
About this task
The file used when creating a new virtual machine becomes the hard disk of that virtual machine.
It cannot then be used to create another new virtual machine. Therefore, it is important to use a
copy of the downloaded file, especially if you are planning to create several virtual machines.

Procedure
1. Download the zipped file for the required software release. See Downloading software on

page 28.

2. Unzip the VHDX file and copy the file to a personal folder. Keep this file as your master
copy for that software release.

3. Save a copy of the file and rename it.

4. Move the renamed file to the folder on the Hyper-V server used to store virtual machine
disks. By default it is C:\Users\Public\Documents\Hyper-V\Virtual Hard
Disks.

Next steps
• Now adjust the disk size. See Expanding the file hard disk size on page 48.

Related links
Hyper-V deployment on page 46

Expanding the file hard disk size
About this task
The default hard disk size set in the downloaded file is 100 GB. This may need to be expanded
depending on planned role of the virtual machine. See Profiling on page 15.
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Procedure
1. In Hyper-V Manager, select Action > Edit Disk.

2. In the Locate Disk menu, enter the file path of the VHDX file or browse to the file and click
Next.

3. In the Choose Action menu select Expand and click Next.
4. In the Configure Disk menu set the new size required and click Next.
5. In the Summary menu check the settings. If okay click Finish.

Next steps
• You can now proceed with using the file to create a new virtual machine. See Creating a new

Hyper-V virtual machine on page 49.
Related links

Hyper-V deployment on page 46

Creating a new Hyper-V virtual machine
About this task
After preparing a new VHDX file for the virtual machine it can be used to create a new virtual
machine.

Before you begin
• Copy and rename and the download VHDX file, see Copying and renaming the disk image

file on page 48. The file used for the following process becomes the hard disk of the new
virtual machine and so cannot be reused for other virtual machines.

Procedure
1. Prepare a VHDX file for the new virtual machine . Use the new file for the installation and

not the original file downloaded for the Avaya support site. The file used becomes the hard
disk of the new virtual machine.

2. From the Hyper-V Manager menu bar, select Action > New > Virtual Machine.
Alternatively, you can go to Actions panel, and select New > Virtual Machine.

3. Click Next.
4. Rename the virtual machine you are creating and click Next.
5. Select Generation 1 and click Next.
6. In Assign Memory menu, you can set the memory to match the recommend settings for

the server's planned role, see Profiling on page 15. However, you can accept the default
and adjust the memory later during the virtual machine profiling stage and click Next.

7. In Configure Networking menu, select the network connection that the new virtual
machine should use. Note that the IP Office image expects to obtain an initial IP address

Creating a new Hyper-V virtual machine
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from that network using DHCP. That address can then be changed once the virtual
machine has been started, then click Next.

8. In theConnect Virtual Hard Disk menu select Use an existing virtual hard disk .

9. Browse to and select the VHDX file that you prepared for this new virtual machine and click
Next.

10. In the Summary menu, click Finish. The new virtual machine should now appear in the list
of virtual machines.

11. Do not start the virtual machine at this stage.

Next steps
• Do not start the virtual machine at this stage. If intending to support Media Manager, see 

Adding an additional hard disk on page 50, otherwise perform any required virtual machine
profiling, see Virtual machine profiling on page 32.

Related links
Hyper-V deployment on page 46

Adding an additional hard disk
About this task
To run the Media Manager application on the same IP Office server as Voicemail Pro, it must be
provided with and configured to use an additional hard disk. This requirement applies even is
running on a virtual machine. This process must be performed before initial server ignition.
The minimum supported size is 30 GB. However, the recommended size is 300 GB or higher.
Remember that for a virtual machine installation of Media Manager, archiving to Blu-Ray/DVD disk
is not supported. See Media Manager archiving on page 13.

• Media Manager typically requires 60 KB per minute for non-authenticated files and 120 KB
per minute for authenticated files.

• Media Manager also reserves 1 GB of space for the call details database and other
operations.

• Media Manager typically requires 60 KB per minute for non-authenticated files and 120 KB
per minute for authenticated files.

• Media Manager also reserves 1 GB of space for the call details database and other
operations.

Procedure
1. In the list of virtual machines, select the required virtual machine.

2. Right-click and select Connect.

3. If the virtual machine is already running, stop it by clicking the . This stops the services
provided by the virtual machine.
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4. In the virtual machine connection window, select File > Settings.

5. Select IDE Controller 0.

6. Select Hard Drive and click Add.

7. Select Virtual hard disk and click New.

8. See the location and name for the file that will be the additional virtual for the virtual
machine.

9. In the Locate Disk menu, enter the name for the new virtual hard disk file and click Next.
10. In the Summary menu check the settings. If okay, click Finish.

Next steps
• Do not start the virtual machine at this stage, instead first perform any required virtual

machine profiling, see Virtual machine profiling on page 32.
Related links

Hyper-V deployment on page 46

Hyper-V virtual machine profiling
After deploying a virtual machine, you should optimize its allocated resources to meet the
requirements of the virtual machine’s role, see Profiling on page 15. For example, if the virtual
machine will only support 50 users, you can reduce the allocated processors and RAM memory.
This allows for the best use of the overall resources provided by the virtual server platform.

Attribute Description
Memory You can set the maximum amount of RAM memory that the virtual machine can use. You

can also set how much of that RAM memory the platform guarantees for the virtual
machine.

See Adjusting the virtual machine's RAM memory settings on page 52.
Processors You can configure multiple virtual processor (vCPUs) for a virtual machine. A virtual

machine cannot have more vCPUs than the maximum number of logical CPUs on the host
virtual server platform. The number of logical CPUs is the number of physical processor
cores.

See Adjusting the virtual machine's processors on page 53.

After profiling, you can start the virtual machine.

• Profiling Other Virtual Machines: It is good practice to monitor the resource utilization of all
the virtual machines running in their infrastructure. Profile all virtual machines running on the
virtual server platform to fine-tune the hardware resources allocated and used. This will
improve performance by allocating resources where they are needed and optimize the use of
their virtual infrastructure.

Hyper-V virtual machine profiling

October 2021 Deploying Avaya IP Office Servers as Virtual Machines 51
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Deploying Avaya IP Office Servers as Virtual Machines


• Multiple IP Office Servers: If deploying servers with the intention of using resiliency, then
the hardware resources and profiling applied to each server must include allowance for the
scenarios where users re-register from one server to the other, effectively increasing the
server's user requirements. If there is a mix of non-virtualized and virtualized machines, then
the assignment of resources to the virtual machine must match the hardware resources
available in the non-virtualized machine.

Related links
Hyper-V deployment on page 46
Adjusting the virtual machine's RAM memory settings on page 52
Adjusting the virtual machine's processors on page 53

Adjusting the virtual machine's RAM memory settings
About this task
You can set the maximum amount of RAM memory that the virtual machine can use. You can also
set how much of that RAM memory the platform guarantees for the virtual machine. Set these
values to match the virtual server’s profile requirements. See Profiling on page 15.

Before you begin
• The following processes can be used on a new virtual machine that has not been powered

on/started.
• To perform the same actions on an existing virtual machine, it must first be powered off/

stopped before making the adjusting and then powered on/started again. That will interrupt all
services provided by the virtual machine.

Procedure
1. In the list of virtual machines, select the required virtual machine.

2. Right-click and select Connect.

3. If the virtual machine is already running, stop it by clicking the . This stops the services
provided by the virtual machine.

4. In the virtual machine connection window, select File > Settings.

5. Select Memory.

6. Adjust the memory settings to match the recommended settings for the server role. See 
Profiling on page 15

7. Click Apply.

Next steps
• If doing as part of installing a new virtual machine, continue with any further profiling required.

When completed, start the virtual machine (see Starting the virtual machine on page 54).
Related links

Hyper-V virtual machine profiling on page 51

Hyper-V deployment
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Adjusting the virtual machine's processors
About this task
You can configure multiple virtual processor (vCPUs) for a virtual machine. A virtual machine
cannot have more vCPUs than the maximum number of logical CPUs on the host virtual server
platform. The number of logical CPUs is the number of physical processor cores.
Note that the CPU core clock speed affects the range selection. When the CPU is at the low end
toward 2 GHz, use the higher number of CPUs. When the CPU speed is higher, for example 3.6
GHz, use the lower number of CPUs.
The CPU core clock speed multiplied by the number of cores, must meet the aggregate CPU cycle
requirements of the virtual machine. See Profiling on page 15.

Before you begin
• The following processes can be used on a new virtual machine that has not been powered

on/started.
• To perform the same actions on an existing virtual machine, it must first be powered off/

stopped before making the adjusting and then powered on/started again. That will interrupt all
services provided by the virtual machine.

Procedure
1. In the list of virtual machines, select the required virtual machine.

2. Right-click and select Connect.

3. If the virtual machine is already running, stop it by clicking the . This stops the services
provided by the virtual machine.

4. In the virtual machine connection window, select File > Settings.

5. Select Processor.
6. Adjust the settings to match the recommended settings for the server role. See Profiling on

page 15.

7. Click Apply.

Next steps
• If doing as part of installing a new virtual machine, continue with any further profiling required.

When completed, start the virtual machine (see Starting the virtual machine on page 54).
Related links

Hyper-V virtual machine profiling on page 51

Hyper-V virtual machine profiling

October 2021 Deploying Avaya IP Office Servers as Virtual Machines 53
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Deploying Avaya IP Office Servers as Virtual Machines


Starting the virtual machine
About this task
Having installed and profiled the new virtual machine, it can be started. This will boot it from the
virtual hard disk file after which the initial IP Office server configuration can be started. See Initial
server configuration on page 71.

Procedure
1. In the list of virtual machines, select the required virtual machine.

2. Right-click and select Connect.
3. In the virtual machine connection window click on the  icon or alternatively select

Action > Start to start the virtual machine.

• For a new virtual machine, the virtual machine now goes through the standard Linux
start up process seen on physical servers. This includes partition resizing and other
processes and can take approximately 15 minutes to complete.

• The server displays the address details for further configuration of the server.

Next steps
Use the address to start the initial server configuration process. See Initial server configuration on
page 71.

Related links
Hyper-V deployment on page 46

Hyper-V deployment
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Part 4: Amazon Web Services
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Chapter 8: Amazon deployment

IP Office server's are supported as AWS virtual machines, referred to as 'instances'. Each AWS
instance is created using a combination of parts:

• Machine Instance: This defines the processor and memory and other factors of the platform
on which the virtual machine is run. AWS provide a range of different machine instances
(https://aws.amazon.com/ec2/instance-types). The machine instance selected should match
the profiling requirements of the server's intended IP Office role. See AWS profiling on
page 57.

• Disk Storage: Storage can be associated with the virtual machine. AWS supports several
different types of storage, however for IP Office it is assumed that a drive or drives using EBS
(Elastic Block Storage) are used.

• Amazon Machine Image (AMI): This is a file that contains the initial image for the virtual
machine.

- The name of the file indicates the release of IP Office software. Note that separate files exist
for Powered By Avaya IP Office (Virtualized) deployments and those that are not. The later,
covered in these notes, include cpe in the AMI file name.

- The same image is used to create the different types of IP Office server. The server type is
decided during initial server configuration.

• Virtual Private Cloud (VPC): This is the customer's private network within an AWS cloud. It
defines the private IP addresses you can use for the instances launched in the network and
provides a range of features for controlling the traffic between the VPC and the public internet;
route tables, internet gateways, public IP addresses, etc. This documentation does not cover
the configuration of the customer's VPC.

• Security Group: A security group controls external internet access to a particular virtual
machine. Each security group consists of a set of rules defining the allow access based on
protocol, port and source address. You can define multiple security groups and then select
which one is currently used by a particular instance.

The process of combining the instances to create a new virtual IP Office server is referred to as
'launching an instance'. During that process, the AWS menus request details of the components to
use and the settings to be applied to those components.

This section outlines the steps required to deploy an IP Office server as a virtual machine. If
deploying several virtual machines, the order of deployment and configuration is the same as per
the Server Edition deployment documentation. see Related Documentation on page 8.
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In addition to certified IP Office training, the installer and system maintainer must have certified
training on the specific virtual platform type or supported by someone who has the required
certification.

During deployment, you must ensure that the deployment of oneIP Office virtual machine has
completed, including setting the LAN1 and LAN2 IP addresses to the required values, before
starting the deployment of any other IP Office virtual machine.

Related links
AWS profiling on page 57
Creating security groups on page 57
Launching a new instance on page 58
Changing the security group on page 60
Changing the machine instance on page 60

AWS profiling
The AWS machine instance https://aws.amazon.com/ec2/instance-types and storage specified
when launching a new instance should match the requirements of the virtual server's intended
role. See Profiling on page 15.

Related links
Amazon deployment on page 56

Creating security groups
Prior to launching any IP Office instances you should create several security groups. A security
group consists of a set of rules for what access is allowed based on a set of selected protocols,
ports and source address settings. When launching a new instance, you can select the security
group that it should use.

• When launching a new instance you should use a highly restricted security group you have
created that allow access from as few hosts and protocols as possible. For example, one that
only allows access from your IP address and using HTTPS access to ports 7070/7071. This
is necessary since the new instance boots with default passwords until initial configuration is
completed.

• Once the instance is ignited and initial configuration utility completed, you can then switch the
virtual machine's security group to one you have created for operational systems. For
example, one that allows access from customer addresses using the ports/protocols of the IP
Office services that have been configured on the server. See Changing the security group on
page 60.

AWS profiling
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Related links
Amazon deployment on page 56

Launching a new instance
About this task
The following is a general example for launching a new virtual instance. The exact process may
vary depending on the requirements of the customer VPC network and external site networks.

Procedure
1. Sign in to your AWS account. Click Services and select EC2.

2. From the top-right corner, select the zone US East (N. Virginia).
3. Click Launch Instance and select Community AMIs and enter Avaya as the search

string.

4. Locate the AMI required and click Select. Make sure you select the correct AMI file

• The name of the file indicates the release of IP Office software. Note that separate files
exist for Powered By Avaya IP Office (Virtualized) deployments and those that are not.
The later, covered in these notes, include cpe in the AMI file name.

• The same image is used to create the different types of IP Office server. The server type
is decided during initial server configuration.

5. Select a machine instance that matches the profiling requirements of the virtual machine's
intended role. See AWS profiling on page 57.

6. Click Next.
a. In Configure Instance Details page, select the customer's VPC and the subnet in

which the virtual machine should operate.

b. To support eth1, under Network interfaces, click Add Device.

If this option is used, AWS will not automatically assign IP addresses to the ports.
After launching the instance, you can obtain the eth0 interface ID and assign a Elastic
IP public IP address which can then be used for ignition and initial configuration.

7. Click Next.
8. In Add Storage page, set the size of the disk to match the profiling requirements of the

virtual machine's intended role. See AWS profiling on page 57.

Note that currently adjusting the disk size following server ignition is not supported.

If the server is supporting Media Manager, it will require an additional separate storage
volume. To add this, click Add New Volume and specify the size required.

9. Click Next.

Amazon deployment
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10. In Add Tags page, enter any tags that you want associated with this instance.

Tags can be displayed and used in other EC2 menus to display, sort and group matching
resources. . Each tag consists of name and value pairs. For example, you might find it
useful to have tags that indicate the server type, the location it serves and the customer

• Server is Primary

• Site is Paris

• Customer is Example.com

11. Click Next.
12. In Configure Security Group page, select the system installer's security group that you

previously created. See Creating security groups on page 57.

Important:

When launching a new instance you should use a highly restricted security group you
have created that allow access from as few hosts and protocols as possible. For
example, one that only allows access from your IP address and using HTTPS access
to ports 7070/7071. This is necessary since the new instance boots with default
passwords until initial configuration is completed.

If you don't select a previously created group, the install process automatically creates
a launch wizard group which only allows SSH access on port 22.

13. Click Review and Launch. Check that the details shown match the requirements for the
server being created. If so, click Launch.

14. Create a new key pair or choose an existing key pair. This provides a security certificate for
secure SSH access to the virtual machine.

15. If creating a new key pair, click Download Key Pair and ensure that you store the
downloaded PEM certificate file in a safe place.

16. Click Launch Instances.

17. If no problems are reported, scroll down the summary form and click View Instances.

Tip:

Alternatively, select Services > EC2 and from the navigation tree select Instances >
Instances.

The list of your instances displays the new virtual machine.

18. The machine starts by performing initial formatting and partitioning of the storage. This
takes approximately 15 minutes to complete.

Next steps
Proceed with the initial server configuration process. See Initial server configuration on page 71.

Related links
Amazon deployment on page 56

Launching a new instance
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Changing the security group
About this task
You can change the security group assigned to an instance. This allows you to maintain a set of
security groups for different purposes and to flexible switch which security group an instance is
currently using. See Changing the security group on page 60.

Procedure
1. Sign in to your AWS account. Click Services and select EC2.

2. In the navigation tree on the left select Instances > Instances.

3. Select the instance for which you want to change the security group.

4. Click Actions and select Change Security GroupsNetworking.

5. Select the security group that you want the virtual machine to use and click Assign
Security Groups.

Related links
Amazon deployment on page 56

Changing the machine instance
About this task
If necessary, you can change the machine instance on which the virtual machine is running.

Important:
This processes requires the server to be stopped and restarted and so ends any calls and
operations currently in progress.

Procedure
1. Sign in to your AWS account. Click Services and select EC2.

2. In the navigation tree on the left select Instances > Instances.

3. Select the instance for which you want to change the machine instance it uses.

4. Click Actions and select Instance State > Stop|. When prompted, select Yes, Stop.

5. Wait until the Instance State has changed to stopped.

6. Click Actions and select Instance Settings > Change Instance Type.

7. Select the type of machine instance required and click ApplyApply.

8. Click Actions and select Instance State > Start. Click Yes, Start.
Related links

Amazon deployment on page 56

Amazon deployment
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Part 5: Microsoft Azure
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Chapter 9: Azure virtual machine
deployment

IP Office server's are supported as virtual machines within Microsoft's Azure environment.

This section outlines the steps required to deploy an IP Office server as a virtual machine. If
deploying several virtual machines, the order of deployment and configuration is the same as per
the Server Edition deployment documentation. see Related Documentation on page 8.

In addition to certified IP Office training, the installer and system maintainer must have certified
training on the specific virtual platform type or supported by someone who has the required
certification.

During deployment, you must ensure that the deployment of oneIP Office virtual machine has
completed, including setting the LAN1 and LAN2 IP addresses to the required values, before
starting the deployment of any other IP Office virtual machine.

Related links
Downloading the Software on page 62
Logging in to Azure on page 63
Creating a Resource Group on page 64
Creating a Virtual Network on page 64
Uploading the VHDX File to Azure on page 65
Creating a New Azure Virtual Server on page 65
Adding an Additional Disk for Media Manager on page 66
Starting an Azure Virtual Machine on page 67
Creating a Copy of an Azure VHDX File on page 68

Downloading the Software
About this task
Avaya make a number of different file available for each IP Office release. For a Azure
deployment, select the following files:

• VHDX file: (Azure) This file is actually downloaded as a zipped file from which you can then
extract the .vhdx file.
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• TTS ISO: The images used to deploy new virtual machines do not include text-to-speech
(TTS) prompts. To add TTS languages, you need to download and install the additional ISO
files for TTS languages. These are provided as 3 ISO files:
- DVD 1: English, Spanish, French, German, Italian.
- DVD 2: Swedish, Norwegian, Finnish, Dutch, Danish, Portuguese, Greek.
- DVD 3: Chinese, Polish, Russian.

Procedure
1. Browse to http://support.avaya.com and log in.

2. Click Support by Product and select Downloads.

3. In the Enter Product Name box, enter IP Office and select the displayed match.

4. Use the Choose Release drop-down to select the required release.

5. From the listed Downloads, select the particular version of the release required (there
may be multiple versions of a release depending on the number of service and feature
packs that have been made available).

6. Click on the required files and follow any further instructions shown by the website and
your browser..

7. Also download and read any documents shown under Related Documents
Next steps

• Create a resource group for the IP Office virtual machines. See Creating a Resource
Group on page 64.

Related links
Azure virtual machine deployment on page 62

Logging in to Azure
About this task
For information on Microsoft Azure, see https://docs.microsoft.com/en-us/azure.

Procedure
1. In your web browser, enter https://portal.azure.com.

2. In the Email, Phone and Skype fields, enter your the registered email.

3. In the Password field, type your password.

4. Click Sign In. The web browser displays the Microsoft Azure portal.

Related links
Azure virtual machine deployment on page 62

Logging in to Azure
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Creating a Resource Group
About this task
A resource group is used to contain sets of related servers. In this case, that can be an IP Office
virtual server or several such servers.

Procedure
1. In the Azure portal, search for resource groups.

2. Click Add to create a new resource group.

3. Complete the required details and click on Review + Create.

Next steps
• Having created a resource group, define the virtual network used by the group. See Creating

a Virtual Network on page 64.
Related links

Azure virtual machine deployment on page 62

Creating a Virtual Network
About this task
Once a resource group has been created for the virtual IP Office servers, a virtual network can
also be created.

Before you begin
• Create a resource group for the IP Office virtual machines. See Creating a Resource

Group on page 64.

Procedure
1. In the Azure portal, search for Virtual Network.

2. Click Add and select the resource group.

3. Enter the virtual network name in Name and select the default Region.

4. Click Next.
5. Under the IP address tab, add the required IP addresses.

6. Click Next.
7. Under the Security tab, select the default security.

8. Click Review + Create.

9. Click Subnets to assign IP to the virtual machines.

Azure virtual machine deployment
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Next steps
• Upload the IP Office .vhdx file. See Uploading the VHDX File to Azure on page 65.

Related links
Azure virtual machine deployment on page 62

Uploading the VHDX File to Azure
Before you begin

• Define the virtual network for use by servers in the resource group. See Creating a Virtual
Network on page 64.

Procedure
1. In the Azure portal, select Storage Accounts.

2. Select the storage account to which you want to upload the .vhdx file.

• If you do not have a storage account, click Add to create one.

• Note that the selected storage location dictate where subsequent image can be created
and deployed.

3. Under BLOB SERVICE, select Containers.

4. Select the container to which you want to upload the .vhdx file.

• If you do not have a storage container, click Add Container to create one.

5. Click Upload and select the .vhdx file to upload.

6. Set the Blob type to Page Blob.

7. This process might take a long time depending on your network connection and the
location of your Azure storage account.

Next steps
• The uploaded file can now be used to create virtual machines. See Creating a New Azure

Virtual Server on page 65.
Related links

Azure virtual machine deployment on page 62

Creating a New Azure Virtual Server
About this task
Follow this procedure to create a new virtual machine from the .vhdx file.

Uploading the VHDX File to Azure
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Before you begin
• Upload the IP Office .vhdx file. See Uploading the VHDX File to Azure on page 65.

Procedure
1. Under Settings > Disks, click Create managed disk.

a. Select the Resource group.

b. Enter the disk name in Disk name.

c. Select the Region.

d. Select Source type.

e. Select Source blob. Browse to and select the previously uploaded .vhdx file.

f. Select the OS type.

g. Select the require disk size.

h. Click Review + Create.

2. Under Settings > Disks, click Create VM.

a. Select the Resource group.

b. Enter the virtual machine name in Virtual machine name.

c. In the Image text box, browse and select the previously uploaded iposerver file.

d. Select the required virtual machine size.

e. In the Authentication type, select Password.

f. Verify the network subnets and click Review + Create.

g.

Next steps
• If intending to support Media Manager, see Adding an Additional Disk for Media Manager on

page 66.
• Otherwise, start the server. See Starting an Azure Virtual Machine on page 67.

Related links
Azure virtual machine deployment on page 62

Adding an Additional Disk for Media Manager
About this task
To run the Media Manager application on the same IP Office server as Voicemail Pro, it must be
provided with and configured to use an additional hard disk. This requirement applies even is
running on a virtual machine. This process must be performed before initial server ignition.

Azure virtual machine deployment
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The minimum supported size is 30 GB. However, the recommended size is 300 GB or higher.
Remember that for a virtual machine installation of Media Manager, archiving to Blu-Ray/DVD disk
is not supported. See Media Manager archiving on page 13.

• Media Manager typically requires 60 KB per minute for non-authenticated files and 120 KB
per minute for authenticated files.

• Media Manager also reserves 1 GB of space for the call details database and other
operations.

• Media Manager typically requires 60 KB per minute for non-authenticated files and 120 KB
per minute for authenticated files.

• Media Manager also reserves 1 GB of space for the call details database and other
operations.

Procedure
1. In the Azure portal, search for and select Virtual Machines.

2. Select the virtual machine from the list.

3. On the Virtual machine page, select Disks.

4. On the Disks page, select Add data disk.

5. In the drop-down for the new disk, select Create disk.

6. In the Create managed disk page, type in a name for the disk and adjust the other
settings as necessary.

7. Click Create
8. In the Disks page, select Save to save the new disk configuration for the VM.

9. After Azure creates the disk and attaches it to the virtual machine, the new disk is listed in
the virtual machine's disk settings under Data disks.

Next steps
• Start the server. See Starting an Azure Virtual Machine on page 67.

Related links
Azure virtual machine deployment on page 62

Starting an Azure Virtual Machine
Procedure

1. In the Azure portal, click Virtual Machines.

2. Select the virtual machine(s) to be started.

3. Click Start.

Starting an Azure Virtual Machine
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Next steps
• If this is a new server, proceed to initial server configuration. See Initial server

configuration on page 71.
Related links

Azure virtual machine deployment on page 62

Creating a Copy of an Azure VHDX File
About this task
Microsoft recommend that number of concurrent virtual machines deployed using the any
particular snapshot or VHD file is limited to 20.
If more than 20 virtual machines are required, an additional disk can be created for the additional
virtual machines.

Procedure
1. In the Azure portal, select All Services.

2. In the All Services search box, enter disks and then select Disks to display the list of
available disks.

3. Select the disk that you would like to use. The page for that disk appears.

4. From the menu at the top, select Create snapshot.
5. Enter a Name for the snapshot.

6. Choose a Resource group for the snapshot. You can use either an existing resource
group or create a new one.

7. For Account type, choose Standard (HDD) or Premium (SSD) storage.

8. When you're done, select Create to create the snapshot.

9. After the snapshot has been created, select Create a resource in the left menu.

10. In the search box, enter managed disk and select Managed Disks from the list.

11. On the Managed Disks page, select Create.

12. Enter a Name for the disk.

13. Choose a Resource group for the disk. You can use either an existing resource group or
create a new one. This selection will also be used as the resource group where you create
the virtual machines from the disk.

14. For Account type, choose Standard (HDD) or Premium (SSD) storage.

15. In Source type, select Snapshot.
16. In the Source snapshot drop-down, select the snapshot created earlier.

Azure virtual machine deployment
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17. Make any other adjustments as needed and then select Create to create the disk.

Related links
Azure virtual machine deployment on page 62

Creating a Copy of an Azure VHDX File

October 2021 Deploying Avaya IP Office Servers as Virtual Machines 69
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Deploying Avaya IP Office Servers as Virtual Machines


Part 6: Server Configuration
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Chapter 10: Initial server configuration

Once a new virtual machine has been started, it requires initial configuration to set the servers’ role
and complete other key configuration settings. Once these have been complete, it should be
possible to license, configure and manage the virtual machine in the same way as a normal physical
IP Office server.

Related links
Connecting to the uninitialized virtual machine on page 71
Performing server ignition on page 73
Adding a certificate to the browser on page 78
IP Office initial configuration on page 81
Configuring the server applications on page 81

Connecting to the uninitialized virtual machine
About this task
Using a browser, use the process below to login and proceed to Performing Server Ignition. See 
Performing server ignition on page 73.

Procedure
1. From a client PC, start the browser and enter https:// followed by the IP address of the

server and :7071. For example https://192.168.42.1:7071
• The virtual machines eth0 IP address is shown in the console window. By default the IP

address for initial configuration is 192.168.42.1/255.255.255.0. If you cannot
connect to the virtual machine using the default IP address, you need to assign the
virtual machine a valid browseable address. See Setting the virtual machine's IP
address on page 72.

2. The login page is displayed. Enter the user name as root and the password
Administrator.

3. Click Login.

Next steps
• Once connected, the server ignition menus are displayed. See Performing server ignition on

page 73.
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Related links
Initial server configuration on page 71
Setting the virtual machine's IP address on page 72

Setting the virtual machine's IP address
A newly deployed IP Office virtual machine uses the following default IP settings: LAN1
192.168.42.1, LAN2 192.168.43.1, Mask 255.255.255.0.

If the default IP settings are incompatible with the existing network where the virtual machine is
being deployed, follow the steps described to change them. Once the settings are correct and the
virtual machine can be accessed with a browser, proceed to perform server ignition.

Before you begin
Warning:

• If using local nodal licensing, the virtual machine uses its IP address as part of the
unique PLDS Host ID used for licensing. Changing the IP address can change the host
ID, invalidating any existing licenses. See Virtual server licensing on page 10. Therefore,
you must ensure that you have confirmed the final IP address settings before setting
these values.

Procedure
1. To open console page:

• Using the vSphere desktop client:

a. Select Inventory view.

b. Locate the required virtual machine in the inventory navigation tree on the left. If not
shown, select View > Show VMs in Inventory.

c. Click on the virtual machine.

d. Click on the Console tab. All cursor and keyboard action are now applied to the
console window.

• Using the vSphere web client:

a. On the Summary tab, in the Guest OS Details pane, click Launch Console.

b. The virtual machine console opens in a new tab of the Web browser.

c. Click anywhere inside the console window to enable your mouse, keyboard, and
other input devices to work in the console.

2. In the console display, enter the command login.

3. Enter user id root and password Administrator.
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4. Once logged in nano /etc/sysconfig/network-scripts/ifcfg-eth0 or ifcfg-eth1, edit the
network settings.

a. Change the BOOTPROTO to static.

b. Set the IP address, mask and default gateway as required.

5. To save the file, press Ctrl+X and enter y.

6. Press enter to save the edited file over the existing file.

7. Enter systemctl restart network.

8. Enter ip a s eth0 or ip a s eth1 to check the address.

9. Power off and then power on the virtual machine again.

Next steps
• Using a browser, connect to the server using the new address. See Connecting to the

uninitialized virtual machine on page 71.
Related links

Connecting to the uninitialized virtual machine on page 71

Performing server ignition
About this task
Server ignition is used to set the server's role and other key settings.

Procedure
1. Using a browser, connect to the virtual machine. See Connecting to the uninitialized virtual

machine on page 71.

2. If you accept the license, select I Agree and click Next.
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3. Select the role that the server should perform and click Next. The subsequent menus vary
depending on the chosen server type.

4. If an additional hard disk was added during the virtual server deployment, details of the
additional hardware appear. Otherwise the menu displays No new hardware
available.

For Media Manager support, it is recommended to accept the defaults. These are:

a. Leave Format Hard Drive checked.

b. Create a single partition for the whole disk. You can create up to 3 logical partitions on
the physical disk.

c. Leave the Mount Point name as /additional-hdd#1. The full mount path name for
each partition is automatically configured by the system adding /partition1, /
partition2 and so on, as a suffix.

For example /additional-hdd#1/partition1. Note that it is this partition name,
including /partition1, that should be used for Media Manager settings.
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d. Select Mount Hardware to have the additional disk automatically mounted.

5. Click Next. Enter the server's network settings.

• Remember that the LAN1 and LAN2 IP addresses and DHCP mode selections affect the
virtual machine's PLDS Host ID used for licensing . Therefore, if using or planing to use
local nodal licensing, we strongly recommended that before obtaining any licenses, you
ensure that these are set to their final values.

• The ignition process allows you to set the IP address for the LAN1 port only. The LAN2
port initially uses the default address 192.168.43.1. To avoid the duplicate IP address
issue you should set the LAN2 address after ignition. This can be done using IP Office
Manager or IP Office Web Manager.

• For AWS virtual machine these settings affect the private IP address settings of the
instance. They do not alter the public IP address values assigned by AWS.

• Hostname is used as the DNS host name of the server.

- For internal applications, this value must be reachable by DNS within the customer
network. If the server is also supporting external applications, the host name also
needs to be reachable by external DNS. Consult with the customers IT support to
ensure that the host name is acceptable and that routing to the host name has been
configured correctly.

6. Click Next.
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7. Set the time source for the server.

• Remember that the virtual machine uses the Timezone for licensing. Therefore, we
strongly recommended that this is set to its final value before obtaining any licenses.

• Select to use the time provided by an NTP server.
• For a virtual server, if not using NTP, the server takes its time from the virtual server's

host platform rather than allow manual configuration through the server menus.
• By default, Secondary Server and Expansion System (L) servers automatically get their

time from the Primary Server and you can only change the Timezone.
• Select the companding setting to use. For telephone systems in North American

locations and Japan, select μ-Law (also referred to as U-Law or Mu-Law). For most
other locations, select A-Law.

8. Click Next.
9. Enter and confirm a new password.

These are the passwords for various IP Office service accounts and also for the Linux
accounts created on the server. Ensure that you note the passwords set.
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10. Click Next.
11. If the selected Server Type was Application Server, select the services provided by the

server.

Unselected services remain installed but not running unless manually started.

12. Click Next.

The menu prompts which security certificate the server should use. This option is not used
for Secondary Server and Expansion System (L) servers.

• If you select Generate CA automatically, you must download the certificate from the
next screen.

• If you select Import CA, click Browse and locate the security certificate file that the
server should use and click Upload.

13. Select whether you want the server to be supported by Avaya through their EASG service
and click Next.

14. Check the displayed summary. Use the Previous and Next options to readjust settings if
necessary.

15. Click Apply.

16. The browser menu will attempt to redirect you to the server IP address you configured
during ignition. Click OK when displayed to access the server's IP Office Web Manager
menus.

AWS: For an AWS virtual machine the browser is redirected to the private IP address of
the server. You need to manually change the browser address back to the instance's public
IP address.

Next steps
• Add the downloaded certificate to our browser, see Adding a certificate to the browser on

page 78. Then proceed to initial configuration, see IP Office initial configuration on
page 81.

Related links
Initial server configuration on page 71
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Adding a certificate to the browser
Browser access to the server uses secure access. The browser used therefore needs to have a
copy of the same CA certificate as used to sign the virtualized server's own identity certificate.

• If the server is using its own auto-generated certificate, you can downloaded the certificate
from the Certificates section of the Settings > General menu. Download the DER-encoded
certificate (a CRT file).

• If the server is using an identity certificate generated elsewhere and then uploaded to the
server, obtain a copy of the CA certificate from the same source.

Related links
Initial server configuration on page 71
Adding a certificate to Firefox on page 78
Adding a certificate to Internet Explorer on page 79
Adding a certificate to Google Chrome on page 79
Adding a certificate to Windows Edge on page 80
Adding a certificate to Mac Safari on page 80

Adding a certificate to Firefox
Procedure

1. Click the  icon and select . Alternatively, click on the  icon if shown on the browser
home page.

2. Click Advanced and select Certificates.

3. Click View Certificates.

4. Click Authorities.

5. Click Import. Browse to the location of the CRT or PEM file downloaded from the server.
Select the file and click Open.

6. Select all the check boxes to trust the certificate.

7. Click OK twice.

Next steps
• If adding the certificate from a newly initialized server, proceed to initial configuration. See IP

Office initial configuration on page 81.
Related links

Adding a certificate to the browser on page 78
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Adding a certificate to Internet Explorer
Procedure

1. Click Tools or the options  icon and select Internet Options.

2. Select the Content tab and click Certificates.

3. Click Import.
4. Click Next and Browse to the location of the downloaded certificate. Select it and click

Open.

5. Click Next.
6. Click Place all certificates in the following store.

• If using the server's own generated certificate, select the Trusted Root Certification
Authorities.

• If using a certificate from another source, select Intermediate Certification
Authorities.

7. Click Next and then Finish.

8. Click OK, Close.

9. Click OK.

Next steps
• If adding the certificate from a newly initialized server, proceed to initial configuration. See IP

Office initial configuration on page 81.
Related links

Adding a certificate to the browser on page 78

Adding a certificate to Google Chrome
Procedure

1. Click the  icon and select Settings.

2. Click Show advanced settings. Scroll to HTTP/SSL and click Manage certificates.

3. Click Import.
4. Click Next and browse to the location of the downloaded certificate. Select it and click

Open.

5. Click Next.
6. Click Place all certificates in the following store.

• If using the server's own generated certificate, select the Trusted Root Certification
Authorities.
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• If using a certificate from another source, select Intermediate Certification
Authorities.

7. Click Next and then Finish.

8. Click OK, Close.

Next steps
• If adding the certificate from a newly initialized server, proceed to initial configuration. See IP

Office initial configuration on page 81.
Related links

Adding a certificate to the browser on page 78

Adding a certificate to Windows Edge
Procedure

1. From the file browser, open the directory containing the certificate file.

2. Right-click the file and select Install Certificate. You may be prompted for admin
credentials and/or a confirmation prompt.

3. On the first wizard screen, click Next.
4. On the Certificate Store screen select Place all certificates in the following store.

• If using the server's own generated certificate, select the Trusted Root Certification
Authorities.

• If using a certificate from another source, select Intermediate Certification
Authorities.

5. Click OK.

Next steps
• If adding the certificate from a newly initialized server, proceed to initial configuration. See IP

Office initial configuration on page 81.
Related links

Adding a certificate to the browser on page 78

Adding a certificate to Mac Safari
Procedure

1. From the browser, open the directory containing the certificate file.

2. Double-click the certificate.

3. You are prompted to store the certificate in the login keychain or the system keychain.
To make the certificate available to all users of this system, select system keychain.
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Next steps
• If adding the certificate from a newly initialized server, proceed to initial configuration. See IP

Office initial configuration on page 81.
Related links

Adding a certificate to the browser on page 78

IP Office initial configuration
About this task
The IP Office service running on the server requires some initial configuration. This is done using
the initial configuration utility (ICU) menu. This menu is automatically shown the first time you login
using either IP Office Web Manager or IP Office Manager.

Procedure
1. Log in to IP Office Web Manager.

a. Enter https:// followed by the server address. Click on the IP Office Web Manager
Web Manager link.

b. Enter the user name Administrator and the password that was created for that
user during ignition.

2. Web manager displays the initial configuration menu for the IP Office service. If this does
not appear, click Solution. Most of the settings are automatically completed using the
values you entered during module ignition.

3. Check the values are as expected. If the module is under centralized management from
Avaya System Manager, select the Centralized Management checkbox. Enter the details
required for Avaya System Manager.

4. Click Apply.

The service is restarted using the values set in the menu. After the restart the browser is
redirected to the normal web management menus.

Related links
Initial server configuration on page 71

Configuring the server applications
The services provided by the virtual machine can now be configured in the same way as for non-
virtual installations. Refer to the appropriate documentation for Voicemail Pro, one-X Portal and
Media Manager. See Related Documentation on page 8.
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Related links
Initial server configuration on page 71
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Chapter 11: Adding TTS languages

The Voicemail Pro application can use Text-to-speech (TTS). However, the IP Office image file used
to create virtual machines does not include the TTS languages. The TTS languages are
downloadable as three separate DVD's. See Downloading software on page 28.

To use TTS languages, you need to upload and install the additional languages on the virtual
machines running the Voicemail Pro application. In a Server Edition network, that applies to the
Primary Server and Secondary Server servers.

Warning:
• TTS files from pre-11.1 releases are not compatible with R11.1.

• During this process, the server needs to restart the voicemail service each time it installs a
new TTS language.

Related links
Checking the TTS languages installed on page 83
Downloading the TTS languages on page 84
Adding a new language on page 84

Checking the TTS languages installed
Procedure

1. Access the server's web control/platform view menus.

2. Select Updates.

3. In the list of Services, each TTS language is shown with the prefix TTS.

Related links
Adding TTS languages on page 83
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Downloading the TTS languages
About this task
Avaya make a number of different file available for each IP Office release. For TTS, select the
following files:

• TTS ISO: The images used to deploy new virtual machines do not include text-to-speech
(TTS) prompts. To add TTS languages, you need to download and install the additional ISO
files for TTS languages. These are provided as 3 ISO files:
- DVD 1: English, Spanish, French, German, Italian.
- DVD 2: Swedish, Norwegian, Finnish, Dutch, Danish, Portuguese, Greek.
- DVD 3: Chinese, Polish, Russian.

Procedure
1. Browse to http://support.avaya.com and log in.

2. Click Support by Product and select Downloads.

3. In the Enter Product Name box, enter IP Office and select the displayed match.

4. Use the Choose Release drop-down to select the required release.

5. From the listed Downloads, select the particular version of the release required (there
may be multiple versions of a release depending on the number of service and feature
packs that have been made available).

6. Click on the required files and follow any further instructions shown by the website and
your browser..

7. Also download and read any documents shown under Related Documents
Related links

Adding TTS languages on page 83

Adding a new language
About this task
Note that this process causes the voicemail service to restart, ending all calls currently being
handled by the voicemail service.

Procedure
1. Access the server's web control/platform view menus.

2. Select Settings > General.
3. In the Software Repositories section, click on the Browse button for Application.

Browse to and select the RPM file for the required language and click OK.
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4. Click Add.

5. Select Updates.

6. In the Services section, locate the newly added TTS language and click Install.
Related links

Adding TTS languages on page 83

Adding a new language
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Part 7: Upgrading
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Chapter 12: Upgrading a virtual machine

Server Edition software supports several methods for upgrading. For virtual machines, the
supported method is to upload the new ISO file to the virtual server, using one of the methods
below, and then select upgrade within the IP Office Web Manager menus.

Method Summary
Transfer from a virtual DVD Upload the ISO file from a virtual DVD drive. You can connect an

ISO file to the virtual machine's DVD drive in several ways.
Transfer from a remote file server Upload the ISO file to the server from a file server (http, https, ftp,

sftp or scp).
Transfer via SSH/SFTP to the virtual
machine

Upload the ISO file directly to a folder on the server using SFTP.

Direct transfer Upload the ISO file to the server using the IP Office Web Manager
browser session.

Warning:
• Not Supported for Upgrades from Pre-R11.1: This method of upgrading is not supported

for upgrading from pre-R11.1 releases. For example, from R11.0 to R11.1. The sever must
be upgraded using the processes in the Upgrading Linux-Based IP Office Systems to
R11.1 manual.

• WARNING: Boot from DVD Upgrades: For non-virtual IP Office servers, the server can
boot from a DVD copy of the ISO. The menu presented includes an option to upgrade.
However, for virtual machines this method of upgrading is not supported.

In a Server Edition network consisting of several servers, you can use IP Office Web Manager to
first upgrade the primary server. The files on the primary are then used to upgrade its associated
secondary, expansion and application servers. Note that this is not possible from a newly installed
virtual primary server.

The VMware Snapshot feature can be used to provide a more robust upgrade process by providing
a fall back point to the previous instance of the virtual machine. See VMware Features on page 22.

Related links
Downloading the software on page 88
Backing up applications on page 88
Transferring the ISO File on page 89
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Downloading the software
About this task
Virtual server upgrades use the same ISO file as used for non-virtual servers.

• ISO file: You can use this type of file to upgrade a previously deployed virtual machine, see 
Upgrading a virtual machine on page 87. Before using an ISO file, you must backup all
applications data and check that you have understood any additional requirements
mentioned in the IP Office Technical Bulletin for the IP Office release. IP Office Technical
Bulletins are downloadable from the same website as the software.

Procedure
1. Browse to http://support.avaya.com and log in.

2. Click Support by Product and select Downloads.

3. In the Enter Product Name box, enter IP Office and select the displayed match.

4. Use the Choose Release drop-down to select the required release.

5. From the listed Downloads, select the particular version of the release required (there
may be multiple versions of a release depending on the number of service and feature
packs that have been made available).

6. Click on the required files and follow any further instructions shown by the website and
your browser..

7. Also download and read any documents shown under Related Documents
Next steps

• Backup the existing servers. See Backing up applications on page 88.
Related links

Upgrading a virtual machine on page 87

Backing up applications
You can configure IP Office Web Manager to backup the servers in a Server Edition network to a
another servers. Refer to the Deploying Avaya IP Office Server Edition Manual manual.

Next steps
• Once you have backed up the servers, proceed with transferring the new ISO file to the

server. See Transferring the ISO File on page 89.
Related links

Upgrading a virtual machine on page 87
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Transferring the ISO File
Having backed up the applications, the next stage is to transfer the ISO file to the Primary Server.
As previously stated, there are number of different methods supported for a virtual machine.

• Transfer from the virtual machine DVD:

- For a physical server, this method uses an ISO file burnt to DVD and placed in the server's
DVD drive. For a virtual machine, there are several methods to connect an ISO file to the
virtual machine's DVD drive. See Transfer from a virtual machine DVD on page 98.

• Transfer from a remote file server:

- Thorough the IP Office Web Manager menus, you can configure the server with the details
of remote file servers from which it can upload an ISO file. See Transfer from a Remote
File Server on page 90.

• Transfer from a primary server path:

- Using SFTP, you can upload the ISO file directly to the server. Within IP Office Web
Manager, you can then use the server file path to download the file. See Transfer from a
primary server path on page 93.

• Transfer from the Web Manage client PC:

- You can transfer an ISO file during a connected IP Office Web Manager session. See 
Transfer the ISO from the IP Office Web Manager client PC on page 96.

Related links
Upgrading a virtual machine on page 87
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Chapter 13: Transfer from a Remote File
Server

You can upload an ISO file to the virtual server from a previously configured file server. The process
for this is the same for virtual and non-virtual machines. See Server Edition documentation for full
details.

Related links
Configuring a remote file server source on page 90
Transferring the ISO from a remote server path on page 90
Upgrading using the Transferred ISO file on page 91

Configuring a remote file server source
Procedure

1. Login to IP Office Web Manager.

2. Click on the Solution Settings drop-down and select Remote Server Options.

3. IP Office Web Manager lists the currently configured remote servers.

4. Click Add Remote Server.
5. Enter details for the remote file server hosting the ISO file. The details required vary

depending on the protocol used by the server.

6. Click OK. The new remote server is now included in the list of remote servers.

7. Click Close.

Related links
Transfer from a Remote File Server on page 90

Transferring the ISO from a remote server path
Procedure

1. Login to IP Office Web Manager.
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2. Click Solution.

3. Click on the Actions drop-down and select Transfer ISO.

4. Click Transfer from and select Remote Location.

5. Click Select Remote Server and select the previously configured remote file server from
the list.

6. In the File Path field, enter the path to the ISO file on that server.

7. Click OK. The menu shows the progress of the download.

8. The servers listed in the Solution overview show an  icon and Upgrade Available.

Next steps
• Proceed with upgrading from the uploaded file. See Upgrading using the Transferred ISO

file on page 91.
Related links

Transfer from a Remote File Server on page 90

Upgrading using the Transferred ISO file
About this task
Having downloaded an ISO file to the server , IP Office Web Manager indicates those servers it
can upgrade. It does this by showing an  icon and Upgrade Available next to the server's
details on the Solution menu.

Warning:
• Not Supported for Upgrades from Pre-R11.1: This method of upgrading is not

supported for upgrading from pre-R11.1 releases. For example, from R11.0 to R11.1. The
sever must be upgraded using the processes in the Upgrading Linux-Based IP Office
Systems to R11.1 manual.

Procedure
1. Login to IP Office Web Manager.

2. Select Solution.

3. Select the checkbox next to each server to upgrade. Upgrades require the primary server
upgraded before any other servers.

4. Click on the Actions drop down and select Upgrade.

5. The upgrade process typically requires the IP Office server to restart, ending the current
web browser connection. If this occurs, login to IP Office Web Manager again to check on
the status of the upgrade.

Upgrading using the Transferred ISO file
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Next steps
If necessary, repeat the process to upgrade all the servers.

Related links
Transfer from a Remote File Server on page 90

Transfer from a Remote File Server
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Chapter 14: Transfer from a primary server
path

SFTP/SSH can be used to upload an ISO file directly to a folder on the virtual machine. The upload
process is typically slow, several hours, but reliable.

Related links
Uploading an ISO file using SSH/SFTP on page 93
Transferring the ISO from a primary server path on page 94
Upgrading using the Transferred ISO file on page 94

Uploading an ISO file using SSH/SFTP
Procedure

1. Start your SFTP or SSH file application and connect to the IP Office Application Server PC.
The exact method depends on the application you are using.

a. Enter the details for the IP Office Application Server:

• The Host Name is the IP address of the IP Office Application Server.

• The User Name is Administrator.
• The Protocol is SFTP/SSH.

• The Port is 22. If this is the first time the application has connected to the server,
accept the trusted key.

b. If this is the first time the application has connected to the IP Office Application Server,
accept the trusted key.

c. When prompted, enter the user password.

2. The default folder displayed after logging in is /home/Administrator.

3. Upload the ISO file to the server.

Related links
Transfer from a primary server path on page 93
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Transferring the ISO from a primary server path
Procedure

1. Login to IP Office Web Manager.

2. Click Solution.

3. Click on the Actions drop-down and select Transfer ISO.

4. Click Transfer from and select Primary Server Path.

5. In the File Path field, enter the path to the previously uploaded ISO file. For example, /
home/Administrator/Downloads/abe-11.1.1-209_el6.iso.

6. Click OK. The menu shows the progress of the download.

7. The servers listed in the Solution overview show an  icon and Upgrade Available.

Next steps
• Proceed with upgrading from the uploaded file. See Upgrading using the Transferred ISO

file on page 94.
Related links

Transfer from a primary server path on page 93

Upgrading using the Transferred ISO file
About this task
Having downloaded an ISO file to the server , IP Office Web Manager indicates those servers it
can upgrade. It does this by showing an  icon and Upgrade Available next to the server's
details on the Solution menu.

Warning:
• Not Supported for Upgrades from Pre-R11.1: This method of upgrading is not

supported for upgrading from pre-R11.1 releases. For example, from R11.0 to R11.1. The
sever must be upgraded using the processes in the Upgrading Linux-Based IP Office
Systems to R11.1 manual.

Procedure
1. Login to IP Office Web Manager.

2. Select Solution.

3. Select the checkbox next to each server to upgrade. Upgrades require the primary server
upgraded before any other servers.

4. Click on the Actions drop down and select Upgrade.

Transfer from a primary server path
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5. The upgrade process typically requires the IP Office server to restart, ending the current
web browser connection. If this occurs, login to IP Office Web Manager again to check on
the status of the upgrade.

Next steps
If necessary, repeat the process to upgrade all the servers.

Related links
Transfer from a primary server path on page 93

Upgrading using the Transferred ISO file
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Chapter 15: Upgrade by Transfer from Your
Client PC

This method of upgrade uses an .iso file transferred directly from your PC through the browser.

Related links
Transfer the ISO from the IP Office Web Manager client PC on page 96
Upgrading using the Transferred ISO file on page 97

Transfer the ISO from the IP Office Web Manager client PC
We do not recommend this method of uploading an ISO file to the server for remote maintenance
of servers not located on the same local network as the PC. The file transfer is slow and does not
continue or automatically resume if the IP Office Web Manager session disconnects during the
transfer.

Procedure
1. Login to IP Office Web Manager.

2. Click Solution.

3. Click on the Actions drop-down and select Transfer ISO.

4. Click Transfer from and select Client Machine.

5. For the Select ISO field, click Browse. Locate and select the ISO file and click Open.

6. Click OK. The menu shows the progress of the download.

7. The servers listed in the Solution overview show an  icon and Upgrade Available.

Next steps
• Proceed to upgrading from a downloaded ISO. See Upgrading using the Transferred ISO

file on page 97.
Related links

Upgrade by Transfer from Your Client PC on page 96
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Upgrading using the Transferred ISO file
About this task
Having downloaded an ISO file to the server , IP Office Web Manager indicates those servers it
can upgrade. It does this by showing an  icon and Upgrade Available next to the server's
details on the Solution menu.

Warning:
• Not Supported for Upgrades from Pre-R11.1: This method of upgrading is not

supported for upgrading from pre-R11.1 releases. For example, from R11.0 to R11.1. The
sever must be upgraded using the processes in the Upgrading Linux-Based IP Office
Systems to R11.1 manual.

Procedure
1. Login to IP Office Web Manager.

2. Select Solution.

3. Select the checkbox next to each server to upgrade. Upgrades require the primary server
upgraded before any other servers.

4. Click on the Actions drop down and select Upgrade.

5. The upgrade process typically requires the IP Office server to restart, ending the current
web browser connection. If this occurs, login to IP Office Web Manager again to check on
the status of the upgrade.

Next steps
If necessary, repeat the process to upgrade all the servers.

Related links
Upgrade by Transfer from Your Client PC on page 96

Upgrading using the Transferred ISO file
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Chapter 16: Transfer from a virtual machine
DVD

One of the options for downloading an ISO image used by IP Office Web Manager is to download
the ISO file from the primary server's DVD drive. To use this option for a virtual machine, you must
first connect the virtual machine's DVD drive to the ISO file.

The VMware client supports the following options for connecting the virtual machine's DVD drive to
a source. This section lists the different methods in order of preference based on speed and
reliability:

• Connect to an ISO file on the client PCs hard disk – This method connects the virtual
machine's DVD drive to an ISO file on the hard disk of the VMware client PC. The time to
complete the upgrade depends on the speed between the vSphere host and the client PC. See 
Connect to an ISO File on the client PCs hard disk on page 99.

• Connect to the client PC DVD drive – This method connects the virtual machine's DVD drive
to the DVD drive of the PC running the VMware client PC. The time to complete the upgrade
depends on the speed between the vSphere host and the client PC. See Connect to the client
PCs DVD drive on page 100.

• Connect to an ISO file in the virtual server datastore – This method connects the virtual
machine's DVD drive to an ISO file previously uploaded to the virtual server datastore. For
remote upgrades, this method is the most reliable. In addition, if multiple virtual machines use
the same datastore, they can access the same ISO file. See Connect to an ISO File in the
virtual server datastore on page 101.

• Connect to the VMware server's DVD drive – This method connects the virtual machine's
DVD drive to a DVD drive on the VMware server PC. This method requires physical access to
a DVD drive on the VMware server. See Connect to the host server's DVD drive on page 104.

Related links
Connect to an ISO File on the client PCs hard disk on page 99
Connect to the client PCs DVD drive on page 100
Connect to an ISO File in the virtual server datastore on page 101
Connect to the host server's DVD drive on page 104
Downloading the ISO from the primary DVD on page 106
Upgrading using the Transferred ISO file on page 106
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Connect to an ISO File on the client PCs hard disk
This method maps the DVD drive of the virtual machine to an ISO file on the PC running the
VMware client.

Related links
Transfer from a virtual machine DVD on page 98
Mapping the virtual machine's DVD to a local PC ISO file (vSphere desktop client) on page 99
Mapping the virtual machine's DVD to a local PC ISO file (vSphere web client) on page 99

Mapping the virtual machine's DVD to a local PC ISO file (vSphere
desktop client)

Procedure
1. Place the ISO file in a folder on your client PC.

2. Using the vSphere client, select the Inventory view.

3. Locate the required virtual machine in the inventory navigation tree on the left. If not
shown, select View > Show VMs in Inventory

4. Click on the virtual machine.

5. Click on the  Connect/disconnect the CD/DVD device of the virtual machine icon in
the toolbar.

• If already connected to a source, the details are shown and the option to disconnect.
Select disconnect and then click the  icon again.

6. From the drop-down, select CD/DVD drive 1 and then select Connect to ISO image on
local disk.

7. Select the ISO file and click Open.

Next steps
• You can now download the ISO to the virtual server using the DVD Primary Server option in

the IP Office Web Manager menus. See Downloading the ISO from the primary DVD on
page 106.

Related links
Connect to an ISO File on the client PCs hard disk on page 99

Mapping the virtual machine's DVD to a local PC ISO file (vSphere
web client)

Procedure
1. Place the ISO file in a folder on your client PC.

Connect to an ISO File on the client PCs hard disk
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2. Using the vSphere web client, select the virtual machine. For example, select vCenter
Management and in the navigation tree on the left select the virtual machine.

3. Click on the  icon in the toolbar.

4. From the CD/DVD drive drop-down, select CD/DVD drive 1 and then select Connect to
ISO image on local disk.

5. Select the ISO file and click Open.

6. You can now download the ISO to the virtual server using the DVD Primary Server option
in the IP Office Web Manager menus.

Next steps
• You can now download the ISO to the virtual server using the DVD Primary Server option in

the IP Office Web Manager menus. See Downloading the ISO from the primary DVD on
page 106.

Related links
Connect to an ISO File on the client PCs hard disk on page 99

Connect to the client PCs DVD drive
This method maps the DVD drive of the virtual machine to the DVD drive of the PC running the
VMware client.

On some Windows operating systems, access to the client PC DVD drive requires vSphere to run
with local administrator rights. For details refer to the VMware Knowledge Base.

Related links
Transfer from a virtual machine DVD on page 98
Mapping the virtual machine’s DVD to the local PC drive (vSphere desktop client) on page 100
Mapping the virtual machine's DVD to local PC drive (vSphere web client) on page 101

Mapping the virtual machine’s DVD to the local PC drive (vSphere
desktop client)

Procedure
1. Insert the DVD into the PC's DVD drive.

2. Using the vSphere client, select the Inventory view.

3. Locate the required virtual machine in the inventory navigation tree on the left. If not
shown, select View > Show VMs in Inventory

4. Click on the virtual machine.

Transfer from a virtual machine DVD
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5. Click on the  Connect/disconnect the CD/DVD device of the virtual machine icon in
the toolbar.

• If already connected to a source, the details are shown and the option to disconnect.
Select disconnect and then click the  icon again.

6. From the drop-down, select CD/DVD and then select the appropriate drive letter for the PC
drive containing the DVD.

Next steps
• You can now download the ISO to the virtual server using the DVD Primary Server option in

the IP Office Web Manager menus. See Downloading the ISO from the primary DVD on
page 106.

Related links
Connect to the client PCs DVD drive on page 100

Mapping the virtual machine's DVD to local PC drive (vSphere
web client)

Procedure
1. Insert the DVD into the PC's DVD drive.

2. Click Virtual Machines and select a virtual machine from the list and click it.

3. Click the Manage tab, and click the CD/DVD connection icon.

4. Select an available drive to connect to, and browse for the CD/DVD media.

5. An Access Control dialog box opens. Click Allow to proceed. To change your selection,
click the connection icon, select Disconnect, and select a different option.

6. Click OK.

Next steps
• You can now download the ISO to the virtual server using the DVD Primary Server option in

the IP Office Web Manager menus. See Downloading the ISO from the primary DVD on
page 106.

Related links
Connect to the client PCs DVD drive on page 100

Connect to an ISO File in the virtual server datastore
This method uses an ISO file uploaded to the file datastore used by the virtual machine.

Related links
Transfer from a virtual machine DVD on page 98

Connect to an ISO File in the virtual server datastore
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Uploading an ISO file to the datastore (vSphere desktop client) on page 102
Uploading an ISO file to the datastore (vSphere web client) on page 102
Mapping the virtual machine DVD to an ISO file in the datastore (vSphere desktop client) on
page 103
Mapping the virtual machine DVD to an ISO file in the datastore (vSphere web client) on page 104

Uploading an ISO file to the datastore (vSphere desktop client)
Procedure

1. Place the ISO file in a folder on your client PC.

2. Using the vSphere client, select the Inventory view.

3. Locate the required virtual machine in the inventory navigation tree on the left. If not
shown, select View > Show VMs in Inventory

4. Click on the virtual machine.

5. Select the Summary tab on the right.

6. In the Resources section, right click on the datastore and select Browse Datastore.

7. Click on the  and select Upload File.

8. Browse to the location of the ISO image and click OK.

9. Once the upload has finished, close the Datastore Browser.
Next steps

• You can now map the virtual machine DVD drive to the ISO file. See Mapping the virtual
machine DVD to an ISO file in the datastore (vSphere desktop client) on page 103.

Related links
Connect to an ISO File in the virtual server datastore on page 101

Uploading an ISO file to the datastore (vSphere web client)
Procedure

1. Using the vSphere web client, select the virtual machine. For example, select vCenter
Management and in the navigation tree on the left select the virtual machine.

2. In the inventory, click Datastore and on the Objects tab, select the datastore to which you
will upload the file.

3. Click the  icon.

4. Select the folder that you created or select an existing folder, and click the  icon.

5. If the Client Integration Access Control dialog box appears, click Allow to allow the
plug-in to access your operating system and proceed with the file upload.

Transfer from a virtual machine DVD
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6. On the local computer, find the ISO file and upload it.

7. Once the upload has finished, refresh the datastore file browser to see the uploaded file in
the list.

Next steps
• You can now map the virtual machine DVD drive to the ISO file. See Mapping the virtual

machine DVD to an ISO file in the datastore (vSphere web client) on page 104.
Related links

Connect to an ISO File in the virtual server datastore on page 101

Mapping the virtual machine DVD to an ISO file in the datastore
(vSphere desktop client)

Before you begin
• Upload the ISO file. See Uploading an ISO file to the datastore (vSphere desktop client) on

page 102.

Procedure
1. Use the process above to upload the ISO file to the datastore.

2. Using the vSphere client, select the Inventory view.

3. Locate the required virtual machine in the inventory navigation tree on the left. If not
shown, select View > Show VMs in Inventory

4. Click on the virtual machine.

5. Click on  Connect/disconnect the CD/DVD device of the virtual machine in the
toolbar.

• If already connected to a source, the details are shown and the option to disconnect.
Select disconnect and then click the  icon again.

6. From the drop-down, select CD/DVD drive 1 and then select Connect to ISO image on
datastore.

7. Select Datastore ISO File and click Browse.

8. Select the ISO file and click OK.

Next steps
• You can now download the ISO to the virtual server using the DVD Primary Server option in

the IP Office Web Manager menus. See Downloading the ISO from the primary DVD on
page 106.

Related links
Connect to an ISO File in the virtual server datastore on page 101

Connect to an ISO File in the virtual server datastore
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Mapping the virtual machine DVD to an ISO file in the datastore
(vSphere web client)

Before you begin
• Upload the ISO file. See Uploading an ISO file to the datastore (vSphere web client) on

page 102.

Procedure
1. Use the process above to upload the ISO file to the datastore.

2. Right-click the virtual machine and select Edit Settings.

a. To locate a virtual machine, select a datacenter, folder, cluster, resource pool, host, or
vApp.

b. Click the Related Objects tab and click Virtual Machines.

3. Expand CD/DVD, and select Datastore ISO File from the drop-down menu.

4. Browse to select the file and click OK.

5. Click Edit and select Connected next to the datastore ISO file to connect the device.

6. Click OK.

Next steps
• You can now download the ISO to the virtual server using the DVD Primary Server option in

the IP Office Web Manager menus. See Downloading the ISO from the primary DVD on
page 106.

Related links
Connect to an ISO File in the virtual server datastore on page 101

Connect to the host server's DVD drive
This method uses an ISO file burnt to DVD and then placed into the physical DVD drive of the
VMware server platform. Whilst this method is fast, it requires access to the physical virtual server
platform.

Related links
Transfer from a virtual machine DVD on page 98
Mapping the virtual machine DVD to the host DVD drive (vSphere desktop client) on page 105
Mapping the virtual machine DVD to the host DVD drive (vSphere web client) on page 105

Transfer from a virtual machine DVD
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Mapping the virtual machine DVD to the host DVD drive (vSphere
desktop client)

Procedure
1. Insert the DVD into the host server's DVD drive.

2. Using the vSphere client, select the Inventory view.

3. Locate the required virtual machine in the inventory navigation tree on the left. If not
shown, select View > Show VMs in Inventory

4. Click on the virtual machine.

5. Click on the  Connect/disconnect the CD/DVD device of the virtual machine icon in
the toolbar.

• If already connected to a source, the details are shown and the option to disconnect.
Select disconnect and then click the  icon again.

6. From the drop-down, select CD/DVD and then select Connect to host device.

7. From the drop-down list, select the host device to use. For example, a typical entry for a
CD/DVD drive is /vmfs/devices/cdrom/mpx.vmhba0:C0T0L0.

8. Click OK.

Next steps
• You can now download the ISO to the virtual server using the DVD Primary Server option in

the IP Office Web Manager menus. See Downloading the ISO from the primary DVD on
page 106.

Related links
Connect to the host server's DVD drive on page 104

Mapping the virtual machine DVD to the host DVD drive (vSphere
web client)

Procedure
1. Insert the DVD into the host server's DVD drive.

2. Right-click the virtual machine and select Edit Settings.

a. To locate a virtual machine, select a datacenter, folder, cluster, resource pool, host, or
vApp.

b. Click the Related Objects tab and click Virtual Machines.

3. On the Virtual Hardware tab, expand CD/DVD and from the drop-down menu select Host
Device.

Connect to the host server's DVD drive
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4. If more than one type of CD/DVD media is available on the host, select the media.

5. Click OK.

Next steps
• You can now download the ISO to the virtual server using the DVD Primary Server option in

the IP Office Web Manager menus. See Downloading the ISO from the primary DVD on
page 106.

Related links
Connect to the host server's DVD drive on page 104

Downloading the ISO from the primary DVD
About this task
Having connected the virtual server's DVD to an ISO source as above, you can now use IP Office
Web Manager to download that ISO source to the server.

Procedure
1. Login to IP Office Web Manager.

2. Click Solution.

3. Click on the Actions drop-down and select Transfer ISO.

4. Click Transfer from and select DVD Primary Server.
5. Click OK. The menu shows the progress of the download.

6. The servers listed in the Solution overview show an  icon and Upgrade Available.

Next steps
• Proceed with upgrading from the uploaded file. See Upgrading using the Transferred ISO

file on page 106.
Related links

Transfer from a virtual machine DVD on page 98

Upgrading using the Transferred ISO file
About this task
Having downloaded an ISO file to the server , IP Office Web Manager indicates those servers it
can upgrade. It does this by showing an  icon and Upgrade Available next to the server's
details on the Solution menu.

Transfer from a virtual machine DVD
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Warning:
• Not Supported for Upgrades from Pre-R11.1: This method of upgrading is not

supported for upgrading from pre-R11.1 releases. For example, from R11.0 to R11.1. The
sever must be upgraded using the processes in the Upgrading Linux-Based IP Office
Systems to R11.1 manual.

Procedure
1. Login to IP Office Web Manager.

2. Select Solution.

3. Select the checkbox next to each server to upgrade. Upgrades require the primary server
upgraded before any other servers.

4. Click on the Actions drop down and select Upgrade.

5. The upgrade process typically requires the IP Office server to restart, ending the current
web browser connection. If this occurs, login to IP Office Web Manager again to check on
the status of the upgrade.

Next steps
If necessary, repeat the process to upgrade all the servers.

Related links
Transfer from a virtual machine DVD on page 98

Upgrading using the Transferred ISO file
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